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Course Objectives 

• Overview of Travel and Accounts Payable in the NBS

• Treasury Payment Batches

• Travel-Related AP Adjustments

• Debit Memos and Travel Refunds

• GTA Reconciliation Support Activities

• Invoice and Payment Processing Error Resolution

• Accounts Payable Maintenance

• Supplier Inquiry

• Important Information
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Agenda

Day 1  
8:30 – 9:00:  Course Overview
9:00 – 9:30: Overview of Travel and Accounts Payable in the NBS
9:30 – 3:30  Treasury Payment Batches

Day 2
8:30 – 9:30:  Review
9:30 – 11:00:  GTA Support Activities
11:00 – 2:00:  Invoice and Payment Processing Error Resolution
2:00 – 3:30:  Supplier Inquiry
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Agenda

Day 3  
8:30 – 9:30:  Review
9:30 – 2:00:  Travel-related Adjustments
2:00 – 3:30:  Debit Memos and Travel Refunds

Day 4
8:30 – 9:30:  Review
9:30 – 12:00:  Accounts Payable Maintenance
1:00 – 3:00:  Invoice and Payment Processing Error Resolution
3:00 – 3:30:  Wrap up
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Training Guidelines 

1. Ask Questions

2. Cheating is encouraged

3. Don’t let me get ahead

4. Have fun!
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Accessing Oracle via the NIH Portal

Oracle is a web-based application available via the NIH Portal

NIH Portal website:  http://my.nih.gov
To Log on use your:

NIH Domain
User Name
Password

For assistance, contact NIH Help Desk at 6-HELP (301.496.4357).

Add the Budget & Finance Community, which is the page where the 
Oracle application resides
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Logging in to the NIH Portal

 
Follow steps below to access the NBS Travel System application from the NIH Portal. 
• Launch Internet Explorer.  In the browser, navigate to the NIH Portal at http://my.nih.gov. 

(Note: If you need Internet Explorer installed on your computer, please contact the NIH Help 
Desk at 6-HELP (301-496-4357)  

• Sign in to the NIH Portal according to the steps listed below, using the account information 
you currently use to log on to Windows at your workstation. 

• Select your domain from the pull-down menu. (Hint: Use the "Which 
domain should I select? link for assistance.)  

• Enter your User name. 
• Enter your Password. 
• Click the Log in button. 

 
For Portal account and password assistance, contact the NIH Help Desk at 6-HELP (301-496-
4357). 
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Adding a Community to your NIH Portal View

1

2

3

4

5

 
What is a Portal Community and how do I subscribe to a Portal Community? 
 
Portal Communities provide content, documents and application access to users who have a 
common area of interest.  Once you subscribe to a community, it will appear in the list on your 
Communities tab every time you visit the NIH portal.  Follow the steps below to subscribe to a 
community. 
 

•  Click on the “Communities” tab and select “Edit Your Memberships”.  
•  Locate a community of interest either by clicking a folder to browse for communities or 

by entering a key word in the Search field and clicking "Go" to look for a specific 
community. 

•  Once you locate a community of interest, select it by clicking in the box next to the 
community name. 

•  Click “Add to my Memberships”. (You may need to select your default community.) 
•  Click “Finish”.  The subscribed community will now appear in the list on your 

“Communities” Tab every time you access the portal.  
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Questions

Questions?
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How to Use the Manual

Each Student Guide contains a Table of Contents
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How to Use the Manual

Each Chapter constitutes a lesson
Each lesson has a set of objectives
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How to Use the Manual

The lessons contain information on the business processes as well as 
step-by-step instructions on how to perform tasks in the NBS
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How to Use the Manual

Step-by-step instructions on
how to perform tasks in the
NBS are contained in
“Navigation” documents.

Navigations:
1. May contain a Purpose or 

Prior Activity section
2. Contain a Navigation Box 

on the first page
3. Contain a picture of the 

screen that you will use to 
enter the data

1

2

3
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Navigation Boxes describe how to get to the appropriate screen in 
Oracle to perform the task

Navigation Boxes are always followed by a screen shot of the window 
you will navigate to.

NIH Receivables Customer Entry Oracle Responsibility

N > Customers > Standard Navigation Path
Find/Enter Customers                                            Screen Name

How to Use the Manual
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How to Use the Manual

1. Directive 
statements will 
help you 
determine your 
next step.  The 
statements are 
indicated in Bold

2. Words in Bold
font indicate a 
field, window, or 
button name

2

1
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How to Use the Manual

The shaded fields indicate that the entry is optional or that you should 
accept the default values

If a field is not referenced, you should not change the default value.
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How to Use the Manual

Notes provided after the task instruction provide useful information or 
helpful hints to complete the step.
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How to Use the Manual

The end of the 
task will be 
indicated by 
End of Activity.
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How to Use the Manual

Each lesson concludes with a Lesson Summary
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Lesson Objectives 

After this lesson you should know:

• What Accounts Payable functionality is being used for 
Track 2

• How invoices are generated

• How payments are generated and recorded
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Track 2 Accounts Payable Purpose 

The main purpose of Accounts Payable is to pay individual travelers and 
vendors for travel-related services.

NIH Travel Voucher

Travel er: John Smith

#TR35697-V1

Airfare - $325

Hotel - $200

Per Diem - $100

NIH Travel 
Authorization

Travel er: John Smith

#TR35697-V1

Advance Requested 
- $240

 
The majority of travel-related payments are made to  
• Individual travelers 
• Impac Government Services (for TMC airfare charges) 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Accounts Payable Overview   
 Chapter 3 - Page 5  

Track 2 Accounts Payable Purpose 

Page 3

Track 2 Accounts Payable Purpose 

In the event that a person is paid too much, Accounts Payable will be 
used to record the amount due to the NIH and the payments that have 
been received.

NIH Cashier
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Accounts Payable Functionality

In order to process travel-related payments and refunds, the following functions
must be performed:

1. Traveler and Vendor information is 
maintained in the supplier table

2. Supplier bank information is 
maintained in the bank table

3. Invoices and debit memos are 
received, entered and prepared

4. Payments and refunds are 
generated and recorded

Government 
Accounting Branch

Travel and Cashier Offices

Travel Office
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Relationships with other Financial Modules 

Accounts Payable works with many other financial modules

Accounts Payable

Cash
Management

Purchasing

Projects

Fed Admin

General 
Ledger

PO 
Match

Payment 
Confirmation

Project 
Validation

GTA Payment 
Reconciliation

Accounting 
Interface

 
Accounts Payable works with other modules 
 
Purchasing – AP matches invoices to purchase orders located in the Purchasing module 
 
Cash Management – GTA payments located in the AP module are reconciled to the TMC 
invoice in Cash Management 
 
Projects – AP validates project information located within the Projects module 
 
Fed Admin – AP Treasury Payment Batches are confirmed in Fed Admin 
 
General Ledger – All AP accounting information is transferred to the General Ledger 
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High-Level Travel Payment Flows

Patient and Foreign 
Travelers

Traveler

Payment

NBS Accounts 
Payable

NIH Cashier

TMC

U.S. Treasury

Travel Information

Oracle
AP

Invoices and 
Debit Memos

ACH and Check 
Payment Requests

GTA 
Payments

Cashier  Payment 
Requests and Debit 

Memos

Refunds

Travel
Manager

Payment

Refunds

 
Travel-related Accounts Payable payments can be separated into three distinct groups: 
 
•    Payments made directly through US Treasury 
•    Payments made through NIH Cashiers 
•    Payments made on a GTA Account 
 
Each payment group will have its own specific payment process. 
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Travel Document Processing

The diagram below describes when information is passed to the NBS Financial 
Modules from the NBS Travel System

NBS Travel 
System

Accounts
Receivable

General 
Ledger

Accounts
Payable

Purchasing

Obligation

Sponsored 
Invoice

Authorization Related

Voucher Related

Sponsored In- kind

Cash 
Management

Travel er/
GTA 

Invoices

 
Accounts Payable may receive information from the NBS travel system upon the approval of 
both a travel authorization (order) and a voucher. 
 
Approval of Travel Authorization 
If an advance is approved, a prepayment invoice may flow into Accounts Payable for travel 
advances. 
 
Approved Travel Voucher 
After a travel voucher is approved, three documents may flow into Accounts Payable: 
• An invoice for expenses reimbursable to the traveler 
• An invoice for expenses charged through a TMC 
• A debit memo for outstanding advance due to the NIH 
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Accounts Payable Invoices and Payments

US 
Treasury

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices and Debit 
Memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment 
and ref und

• Inv oices are prepared 
f or pay ment

• Pay ment batches are 
generated f or Treasury

• Pay ments and 
Ref unds are recorded 
by Cashier

• Pay ments are 
recorded f or GTA 
Reconciliation

Cash 
Management

• Pay ments are 
reconciled to 
TMC File
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Invoice Import from NBS Travel System

AP Open 
Interface

AP
Invoice 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices and Debit Memos imported 
f rom Open Interf ace

• Inv oice batches created f or pay ment 
and ref und

• Inv oices are prepared f or pay ment

 
Invoice batches paid directly through Treasury 

Travel vouchers 
Travel vouchers with prepayments 
Travel advances 

 
Invoice batches not paid directly through Treasury 

Patient and foreign payments 
Individual TMC Charges 
Debit Memos 
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Invoice Workbench

Invoice batches can be:
Imported from other sources or
Created manually

Invoice batches may contain multiple invoices

Invoice Types include:
Prepayment (Advances)
Standard
Debit Memos (Money due to NIH)
Credit Memos (Money due to NIH)

In order for an invoice to be paid, it must be:
Validated
Free of Holds

Invoices must be accounted in order for the accounting 
information to be transferred to the General Ledger

AP
Invoice  

Workbench

• Inv oices and Debit 
memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment 
and ref und

• Inv oices are prepared 
f or pay ment
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Payment Workbench

Payments are:
Batched in AP for transfer to Treasury
Paid from the Cashiers Office and recorded in AP
Recorded in AP for reconciliation in Cash 
Management

Payment types include:
Payment
Refund

AP
Payment 

Workbench

• Pay ment batches are 
generated f or Treasury

• Pay ments and 
Ref unds are recorded 
by Cashier

• Pay ments are 
recorded f or GTA 
Reconciliation
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Travel Invoices Paid Directly by Treasury

US 
Treasury

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem • Inv oices and Debit 

Memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment 
and ref und

• Inv oices are prepared 
f or pay ment

• Pay ment batches are 
generated f or Treasury

• Returned pay ments 
are v oided
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Travel Invoices Paid by Cashier

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem • Inv oices and 

Debit Memos are 
imported f rom 
Open Interf ace

• Inv oices are 
placed on hold

• Pay ments and 
Ref unds are 
recorded by  
Cashier

C
AS

H
IE

R
 H

O
LD

• Inv oices are 
Validated

• Inv oice 
holds are 
released
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Travel Invoices for Expenses Charged by TMC

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices imported 
f rom Open 
Interf ace

• Inv oices are 
placed on hold

• Pay ments are 
recorded

G
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 H
O
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• Inv oice 
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Cash 
Management

• Pay ments are 
reconciled to 
TMC File
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Lesson Summary

In this lesson you learned:

• What Accounts Payable functionality is being used for 
Track 2

• How invoices are generated

• How payments are generated and recorded
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Processing Payment Batches 
to Treasury 
Chapter 4 
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Processing Travel Payments to Treasury 

Processing Travel Payments to Treasury

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 

After this lesson you should know how to:

• Process travel-related payments to Treasury

• Process returned and voided Treasury payments
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Payment

Payments Made Directly by the U.S. Treasury 

Patient and Foreign 
Travelers

Traveler

Payment

NBS Accounts 
Payable

NIH Cashier

TMC

U.S. Treasury

Travel Information

Oracle
AP

Invoices and 
Debit Memos

ACH and Check 
Payment Requests

GTA 
Payments

Cashier  Payment Requests 
and Debit Memos

Refunds

NBS 
Travel

Refunds

The flow of payments made directly by Treasury is emphasized.

1

2

3

4

5

 
The majority of payments to travelers are made directly by the U.S. Treasury. 
 
•   Travelers enter a travel authorization with advance request or a travel voucher into the NBS 

Travel System 
•   Invoices are interfaced into the NBS AP Module. 
•   The OFM Travel Office prepares the files for transfer to the U.S. Treasury 
•   U.S. Treasury processes the payment batch  
•   The check/electronic payment is received by the traveler 
 
OFM may process five payment batches on a daily basis. 
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Travel Invoices Paid Directly by Treasury

US 
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AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem • Inv oices and Debit 

Memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment

• Inv oices are prepared 
f or pay ment

• Pay ment batches are 
generated f or Treasury

• Returned pay ments 
are v oided
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Processing Travel-related Payments to 
Treasury 

After this lesson you should know how to:

Process travel-related payments to Treasury

• Process returned and voided Treasury payments
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Option 3:  Oracle ExtensionTreasury Payment Process

NIH Certifying Officer 
Certifies Payment
Batch

Certify Payment 
Batches in ECS

NIH Payables User 
Processes Treasury 
Payment Batches

1.  Create, Build and 
Select Batch

2.  Review Reports

3.  Modify Batch if 
needed

4.  Format Batch

5.  Confirm Batch

NBS Management Center 
monitors invoice Import 
processes

Invoice batches are imported 
and prepared for payment

NIH Payables User prepares 
invoices for payment

1. Run Reports

3. Validate Invoices

2. Take Corrective Action 
to release or apply holds
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Roles and Responsibilities 

Monitor the invoice import process and resolve import errors

Prepare invoices for payment

Create, Build, and Select Payment Batches

Review the batches and modify, if necessary

Format and confirm the batches

Resolve any invoice or payment processing errors within AP

Certify payment batches in ECS based on the Oracle AP Final 
Register Report

NIH Payables User

NIH Certifying Officer

NBS Management Center
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Invoice Import and Preparation for Treasury

AP Open 
Interface

AP
Invoice 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem • Inv oices and Debit 

Memos imported f rom 
Open Interf ace

• Inv oice batches 
created f or pay ment

• Inv oices are prepared 
f or pay ment

NBS Management Center 
monitors invoice 
Import processes

Invoice batches are 
imported and prepared 

for payment

 
• Invoices are imported from the NBS Travel System nightly for all travel invoices. 
 
• Invoices payable through the Cashier office are imported every 30 minutes. 
 
• Data is imported in batches, which contain multiple invoices. 
 
• In the event that an invoice fails the import process from the AP Open Interface table to the 

AP Invoice Workbench, it will remain in the interface until action is taken to resolve the 
error.  The NBS Management Center is responsible for monitoring the import process and 
resolving the errors.  However, the NIH Travel Office receives a copy of the invoice import 
errors via email. The import error report should be used to help answer traveler inquiries and 
perform the GTA reconciliation when an invoice cannot be found in AP Invoice Workbench. 
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Imported Invoice Batches

Invoices from the NBS Travel System are imported in batches.
Invoice Batches contain multiple invoices.
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Imported Invoice Batches

Daily Invoice Batches

Debit MemoTravelTMDMmmddyyyyDebit Memos

Hold NamePay 
Groups

Invoice Batch 
Name

Contents

Reconciliation ProcessIMPAC TravelTMUSBmmddyyyyGTA Invoices

Patient Recorded PayTravelTMRPPmmddyyyyInvoices for Patients 
and Foreign Travelers

NoneAP AdvanceTMADVmmddyyyyTravel Advances

NoneTravel & Non 
NIH

TMIADmmddyyyyTravel Vouchers w ith 
Prior Advance

NoneTravel & Non 
NIH

TMINVmmddyyyyTravel Vouchers

 
Six travel invoice batches are imported daily.  Each invoice batch may contain multiple invoices.  
Depending upon how the invoices contained in the batch are to be paid, the pay group will be 
selected and the required holds will be placed on the invoices. 
 
Once the travel document is approved in the NBS Travel Management System, the daily invoice 
import process: 
• Imports invoices into invoice workbench with the assigned pay group 
• Places holds as necessary on invoices 
• Matching invoice to purchase order 
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Invoice Validation

Automatically

Automatically

Automatically

Automatically

Automatically

Automatically

Validated

YesNIH Cashiers 
Off ice or Treasury 

Payment Batch

TMDMmmddyyyyDebit Memos

Held?Payment 
Method

Invoice Batch 
Name

Contents

YesRecorded 
Payment Batch

TMUSBmmddyyyyGTA Invoices

YesNIH Cashiers 
Off ice

TMRPPmmddyyyyInvoices for 
Patients and 

Foreign Travelers

NoTreasury Payment 
Batch

TMADVmmddyyyyTravel Advances

NoTreasury Payment 
Batch

TMIADmmddyyyyTravel Vouchers 
with Prior Advance

NoTreasury Payment 
Batch

TMINVmmddyyyyTravel Vouchers

Invoices must be validated to be eligible for payment.   

 
The invoice validation program checks the matching, tax, period status, and distribution 
information for invoices you enter and automatically applies holds to exception invoices. 
 
Invoice batches are validated automatically upon import into the AP Invoice Workbench. 
 
If an error is encountered during the invoice validation program, the NIH Travel Office will be 
responsible for resolving the error.  (See Chapter on “Troubleshooting AP Invoice and Payment 
Processing Errors” in this Student Guide.) 
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Creating Accounting for Invoices

Automatically

Automatically

Automatically

Automatically

Automatically

Automatically

Accounting 
Created

TMDMmmddyyyyDebit Memos

Invoice Batch 
Name

Contents

TMUSBmmddyyyyGTA Invoices

TMmmddyyyyRPPInvoices for Patients 
and Foreign Travelers

TMADVmmddyyyyTravel Advances

TMIADmmddyyyyTravel Vouchers w ith 
Prior Advance

TMINVmmddyyyyTravel Vouchers

The Create Accounting program generates the accounting entries for the 
invoices that will be sent to the General Ledger on a nightly basis

 
The “Create Accounting” program is run automatically for invoices on a nightly basis.   
 
However, if an invoice does not complete the validation program successfully, it will not be 
eligible to be accounted.  The NIH Travel Office is responsible for ensuring that all invoices are 
properly accounted for by month end close.  The Unaccounted Transaction Report displays any 
invoice or payment that has not been accounted. (Refer to Chapter on “Accounts Payable 
Maintenance” in this Student Guide.) 
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Preparing Invoices for Payment

An invoice is eligible for payment when it is cleared of holds and 
validated.  Invoices should also be accounted.

Validated

Cleared of 
Holds

Accounted

 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 15  

Required Payment Information 

Page 13

Required Payment Information

In addition, the following information is required for payment:
Supplier Bank Information and SSN for Treasury Electronic Batches
Supplier Address information and SSN for Treasury Check Batches

+

+

Electronic 
Payment

Check     
Payment
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Invoice Reports

Prior to creating the payment batch, you should 
run the following reports

Invoices On-Hold Report
NIHAP Unpaid Invoices Detail Report

The Invoices On Hold Report will indicate which invoices are on hold 
and thus not eligible for payment

The NIHAP Unpaid Invoices Detail Report will indicate which invoices 
are not eligible for payment due to a lack of SSN, banking, and/or 
address information as well as invoices for which banking has been 
entered.

Refer to the chapter “Accounts Payable Reports” for information on 
how to run and interpret the reports

1. Run Reports
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2. Take Corrective Action 
to release or apply holds

Invoices On Hold Report

The Invoices On Hold Report will indicate which invoices are on hold 
and thus not eligible for payment

• The issues causing the hold should be resolved as much as possible 
prior to running the payment batch.

• Refer to the chapter “Troubleshooting Invoice and Payment 
Processing Errors” in this Student Guide for guidance on resolving 
invoice holds.

• At a minimum, the system hold “Qty Ordered” should be removed.
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2. Take Corrective Action 
to release or apply holds

NIHAP Unpaid Invoices Detail Report

The NIHAP Unpaid Invoices Detail Report will indicate which invoices 
are not eligible for payment due to a lack of SSN, banking, and/or 
address information as well as invoices for which banking has been 
entered.

• Invoices should be placed on hold or invoices should be updated and 
released from hold

• Refer to the chapter on “Accounts Payable Reports” for details on the 
report and how to analyze the results.
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Validating Invoices 

Prior to creating the Treasury Payment batches, you should run the 
validation program to ensure that all invoices are properly validated

1. Run the validation program for the following Pay Groups
AP Advance
Travel
NON NIH

2. Review the log of the validation program to ensure that it 
completes with a status of “Normal”

3. If the program ends in an “Error” status
Review log to determine on which invoice the error was 
encountered
Correct funds checker errors
Re-run validation program

3. Validate Invoices
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Validating Invoices 

If the validation program ends in an Error status, 
select the View Log button to determine on which 
invoice the error occurred.

3. Validate Invoices

 
If the validation program ended in error due to a Funds Checker error, correct the error and run 
the validation program again. 
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Submitting the Invoice Validation Program 
NIH Payables User 

N > Other > Requests > Run 

Submit a New Request 

 

1. Select the OK button to submit a single request. 

Result:  The Submit Request window is displayed. 
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2. In the Name field, select Invoice Validation from the LOV. 

Result:  The Parameters window is displayed. 

 

3. Enter the report parameters as described below:  

 
Field Description 
Option Select All or New from the LOV.  All will validate all current 

invoices in the workbench.  New will validate only new 
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invoices. 
Invoice Batch Name Select the appropriate invoice batch name from the LOV. 
From Invoice Date Select the appropriate beginning invoice date from the LOV. 
To Invoice Date Select the appropriate ending invoice date from the LOV. 
Supplier Name Select the appropriate supplier from the LOV. 
Pay Group Select the appropriate pay group from the LOV. 
Invoice Number Select the appropriate invoice number from the LOV. 
Entered By Select the appropriate document creator from the LOV. 

Important:  In order to limit the invoices that are validated, you should at a minimum utilize 
either the Supplier Name or Pay Group field when running the validation program.   

4. Select the OK button. 

Result:  The Parameters window closes. 

5. Select the Submit button to submit Invoice Validation Program.  

Result:  The Request window is displayed. 

 

6. Select the Refresh Data button until the process indicates a Phase of "Completed". 

If the program ends with a status of Error, goto task #7. Otherwise, end of activity. 

7. Select the View Log button to determine the reason for the error. 
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Result:  The View Log window is displayed. 

 

End of activity. 
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Practice Lab

Lab Time

 
Complete Lab 1:  Preparing Invoices for Payment 
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Treasury Payment Batch Process

NIH Certifying Officer 
Certifies Payment
Batch

Certify Payment 
Batches in ECS

NIH Payables User 
Processes Treasury 
Payment Batches

1.  Create, Build and 
Select Batch

2.  Review Reports

3.  Modify Batch if 
needed

4.  Format Batch

5.  Confirm Batch

NBS Management Center 
monitors invoice Import 
processes

Invoice batches are imported 
and prepared for payment

NIH Payables User prepares 
invoices for payment

1. Run Reports

3. Validate Invoices

2. Take Corrective Action 
to release or apply holds

 
The steps listed under NIH Payables User Processes Treasury Payment Batches must be 
completed for each payment batch. 
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Y = Last digit of the year D  = Day of the year  
# = Sequential number for multiple batches in a single day.

Payment batches should be processed with the 
corresponding payment batch name, invoice 
criteria, document, and transaction code.

List of Daily Treasury Payment Batches

B110EFT.TRAVELPay Group = NON 
NIHTETYDDD#4

B110CHECK.TRAVELPay Group = NON 
NIH

TCKYDDD#5

B110CHECK.TRAVELPay Group = TravelTCKYDDD#3
TETYDDD#

TETYDDDAD#

Payment 
Batch Name*

EFT.TRAVEL

EFT.TRAVEL

Document

Pay Group = Travel

Pay Group = AP 
Advance

Invoice Criteria

B1102

B2061

Transaction 
Code#

1.  Create, Build and 
Select Batch

 
Examples of Payment Batch Names: 
TET3001AD = Travel Advance Electronic payment batch for January 1, 2003 
TET3001AD1 = Second travel advance electronic payment batch for January 1, 2003 
TET3365 = Travel electronic payment batch for December 31, 2003, excluding travel advances. 
TCK3365 = Travel check payment batch for December 31, 2003, excluding travel advances. 
 
Important Guidelines for Treasury Payment Batch Names 
Do not use dashes, periods or other punctuation 
Limit batch names to 10 characters 
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Other Travel Treasury Payment Batches

Other payment batches will be created using the 
invoice batch name to select the invoices.  

Y = Last digit of the year D  = Day of the year
Example:

TET3001SR = Sponsor Refund Electronic payment batch for January 1, 2003

1.  Create, Build and 
Select Batch

TETYDDDSR

Payment Batch 
Name*

Daily

EFT.Travel

Document

Invoice Batch 
Name

Invoice 
Criteria

NONESponsor 
Refunds

Transaction 
CodeType

 
The invoice batch names for Sponsor Refunds will be covered in a subsequent lesson. 
 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 29  

Payment Batches Window 

Page 23

Payment Batches Window 

Note:  This window can be customized for each user to display the fields in the 
order of user preference.  See Navigation Student Guide.

All activities are completed in the Payment 
Batches window.

To view additional fields to the right, you may use 
the horizontal scroll bar.

1.  Create, Build and 
Select Batch

 
In this step, you are 
•  Assigning a Payment Batch name 
•  Indicating the Document type which is tied to a payment method 
•  Indicating which invoices to select by indicating a Pay Group, Invoice Batch Name, and/or 
Supplier Name 
•  Running the Select and Build functions that pulls eligible invoices into a payment batch and 
validates that all payment criteria are met, and 
•  Generating a Preliminary Payment Register Report 
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Payment Criteria 

Eligible invoices will be selected for payment 
based upon the following criteria entered in the 
Payment Batches Window:

1.  Create, Build and 
Select Batch

Pay Group

Invoice Batch Name

Supplier Name

Pay Through Date

Document

Invoice Criteria

 
Pay Group:  Selects invoices in that particular pay group which is identified on the invoice 
header.  The OFM Travel Office utilizes two Pay Groups:  AP Advance and Travel. 
Invoice Batch Name:  (Optional)  Selects invoices within a particular invoice batch name. 
Supplier Name: (Optional)  Selects invoices for a particular supplier 
Pay Through Date:  Defaults to five days from the date the batch was created.  Selects invoices 
that have payment terms and terms date through the date listed on the payment batch window. 
Document:  Determines the Payment Method, check or electronic.   Selects invoice with the 
selected payment method as specified on the invoice. 
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Payments - Create, Select, and Build a Payment Batch for Travel 

Purpose 

The purpose of this document is to describe how to create, select and build payment batches in 
NBS.   

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Click into Transaction Event field and select the appropriate transaction code from the 
LOV. 

Result:  The Transaction code field value defaults.   

2. Select the OK button. 

Result:  The Payment Batches window is displayed.  Use the folder tools to select the NBS 
folder. 
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3. Create the batch by completing the following fields: 

 
Field Description 
Batch Name Enter a batch name. 

Notes: 
This value must be unique.   
Refer to the Payment Batch Naming Convention job aid. 

Payment Date Defaults to the current date. 
Status Defaults to New.  This field cannot be updated 
Next Step Defaults.  This field cannot be updated. 
Pay Group Select the appropriate value from the LOV. 
Invoice Batch Name Select an invoice batch name from the LOV. 

Note:  Only payments for invoices in this batch will be 
selected. 

Bank Account Defaults select Main Disbursement. Do not change 
Document Select a value from the LOV, depending upon the method 

of payment. 
 
Note:  The system will display messages related to the 
reservation of document numbers.  Select the OK button to 
both messages. 

Payment Method Defaults based upon document. 
Pay Through Date Defaults to five days from the current date.   
Supplier Name Select a supplier name from the LOV. 

Note:  Only payments for this supplier will be selected. 
First Document Number Defaults to the next available check or wire transfer 

number. 
Last Document Number Defaults.  Do not change. 
Document Order Defaults to Supplier Name 

Example:  Below is a sample completed Payments window. 
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4. Select the Actions... button. 

Note:  The Payment Batches Action window is displayed. 
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5. Confirm that the Select Invoices and Build Payments check boxes are enabled. 

6. Enable the Print Preliminary Register checkbox. 

7. Tab to the Printer field and select a printer from the LOV. 

Note:  If you do not want the report to print automatically, select no print.  The report will 
still be accessible through the Requests window. 

Example:  Below is a sample completed Payment Batches Action window. 

 

8. Select the OK button. 

Result:  The concurrent request is submitted and a message box is displayed with the request 
ID number. 
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9. Select the OK button. 

Result:  You are returned to the Payment Batches window. 

 

10. Select the Requery Batch button and review the batch status and next step.  Repeat until the 
status changes to Built. 

Example:   

 

If the Status field indicates an error, goto task #11.   

If you want to review an on-line version of the report, goto task #12.  Otherwise, end of 
activity. 

11. Contact the NIH Help Desk. 

End of activity. 

12. From the menu bar, select View > Requests to review the status of your request. 
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Result:  The Find Requests window is displayed 

 

13. Select the Find button. 

Result:  The Requests window is displayed. 

 

14. Select the Refresh Data button to check on the status of the requests until the request lines 
complete with a status of normal. 
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15. Highlight the Preliminary Register Report. 

16. Select the View Output button. 

Result:  The Report - Request ID... window is displayed. 

 

17. Select Tools > Copy File from the menu bar. 

Result:  The Preliminary Register Report will be displayed in a browser window. 
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End of activity. 
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Preliminary Payment Register Report 
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Preliminary Payment Register Report 

The Preliminary Payment Register report is your 
tool to verify that:

2.  Review Reports

• payments included in the batch should be processed;

• payments contain the information necessary to be paid

• no unwanted payments are included in the batch

 
The first page of the report displays the following: 
• The batch name 
• The criteria used to create the batch, (Pay Group, Payment Method, Invoice Batch Name, 

Supplier Name, Pay Through Date) 
• the number of set up documents 
• the number of non-payment documents (those documents that do not have banking 

information, exceed the maximum payment amount or are below the minimum payment 
amount, zero payments allowed, zero invoices allowed, or payment documents that you 
deselected while making modifications to the payment batch) 

• the number of negotiable documents (number of payments in the batch), and 
• the payment batch total. 
 
The subsequent pages display all the payments that were selected for the batch based upon the 

criteria you specified.  For each payment, the report will display: 
• the invoice number(s), 
• the supplier name and number, 
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• the amount of the payment, and 
• the non-payment reason if one is given. 
 
If invoices are selected for payment in the payment batch, but they do not meet payment 
requirements, the invoices are marked by asterisks and a non-payment reason is given.   These 
payments will require additional action before the payment can be made.  Refer to Chapter 
entitled “Troubleshooting AP Invoice and Payment Processing Errors” in this Student 
Guide. 
 
Review the report for any foreign payments or other payments that should not be included in the 
payment batch.  For example, invoices payable to Impac Government Services should not be 
included in a payment batch for Treasury.  Additionally, if you have built a batch for advances, 
only invoices containing the suffix –AD should be included.  All other should be removed. 
 
Note:  If you notice that you have used an incorrect batch name, pay group, and transaction code 
combination, you may cancel the batch while the status is Built. 
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NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch 

Page 26

NIHAP Unpaid Invoices Error Resolution 
Report for Payment Batch

In addition to the Preliminary Register report, the 
NIHAP Unpaid Invoices Error Resolution 
Report for Payment Batch should be run prior 
to moving forward with the batch.
The report will indicate invoices that are:

Missing SSN
Missing Address information
Missing ACH information

2.  Review Reports

All invoices that are displayed on this report should be removed
from the payment batch and placed on hold.
Refer to the chapter “Accounts Payable Reports” for guidance on 
how to interpret the report.
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Submitting the NIH Invoices Error Resolution Report for Payment 
Batch 

NIH Payables User 

N > Payments > Entry > Payment Batches 

Payment Batches 

 

1. From the menu bar, select View > Requests 

Result:  The Find Requests window is displayed. 
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2. Select the Submit a New Request Button. 

Result:  The Submit a New Request window is displayed. 

 

3. Select the OK button to submit a single request. 

Result:  The Submit Requests window is displayed. 
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4. In the Name field, select NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch. 

Result:  The Parameters window is displayed. 

 

5. In the Payment Batch Name field, select the payment batch you are currently processing 
and select the OK button. 

Result:  The Parameters window closes. 
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6. Select the Submit button. 

Result:  The Requests window is displayed. 
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7. Select the Refresh Data button until the request displayed a Phase of Completed. 

8. Select the View Output button to view the report. 

Important:   

• All invoices that are displayed on this report should be removed from the payment batch 
and placed on the applicable hold. 

• We recommend printing this report and filing it with the Preliminary Payment Register 

End of activity. 
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Modifying a Payment Batch 
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Modifying a Payment Batch

You should remove all invoices that you do not 
want to be included in the batch.  

3.  Modify Batch

All invoices that are listed on the NIHAP Unpaid Invoices Error 
Resolution Report for Payment Batch should be removed and 
placed on hold

 
Payment batches can be modified to exclude a payment from the batch. 
Once you modify the payment batch, it must be rebuilt. 
Once rebuilt, we suggest that a revised preliminary register report be run to verify changes made 
to the payment batch. 
 
Reasons to modify the payment batch may include: 
• invoice is displayed on NIHAP Unpaid Invoices Error Resolution Report for Payment Batch 
• a payment of a different type is included in the batch (Example:  advances are included in the 

regular travel batch) 
• foreign payments are in the batch 
• a traveler requests an emergency payment out of the Cashiers Office. 
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Excluding a Single Payment 
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Excluding a Single Payment

To exclude a single payment, change the 
Selected Invoices: Pay field to “No” as shown 
below:

3.  Modify Batch
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Generate New Preliminary Register Report 
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Generate New Preliminary Register Report

We recommend running a new Preliminary 
Register Report 3.  Modify Batch
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Payments - Removing a Payment from a Batch 

Prior Activity 

Before completing this activity, the payment batch must have been created and built.  Refer to 
Create, Select and Build a Payment Batch [NAV1009A]  

Note:  If you did not exit the Payment Batches screen after creating the payment batch, then 
skip Steps 1-6 and proceed directly to Step 7. 

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window by clicking the X in the upper right hand 
corner. 

Result:  A caution message will appear asking you if you want to turn off the enhanced 
transaction code feature. 

2. Select the OK button. 

Result:  The Payment Batches window is displayed. 
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3. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

4. Enter the search criteria to locate the batch, such as the batch name. 

5. Press the Ctrl + F11 keys  

Result:   The batches meeting the search criteria are displayed. 

 

6. Highlight the batch to be modified by placing your cursor in the line. 

7. Select the Payments button. 

Result:  The Modify Payment Batch window is displayed. 
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8. Press the F11 key to enter query mode. 

Result:  Your fields turn blue. 

9. Enter the search criteria. 

Example:  Below is a sample search criteria for the supplier name. 
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10. Press Ctrl + F11 keys to execute the query. 

Result:  The invoices that match your search criteria are displayed. 

11. Use the Page Down button on your keyboard to scroll through the search results to find the 
invoice you would like to exclude. 

12. In the Pay field in the Selected Invoices block, select No from the drop down menu to 
exclude the invoice from the payment batch. 

Example:  Below is a sample completed screen. 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 54  

 

If there are additional invoices to exclude, goto task #8. Otherwise, goto task #13. 

13. Save the record 

14. Close the Modify Payment Batch window. 

Result:  The Build payment batch process is automatically submitted.  A message will be 
displayed indicating the request ID number. 

 

15. Select the OK button. 

Result:  You are returned to the Payment Batches window. 
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16. Select the Requery Batch button until the Status changes from Rebuilding to Built. 

17. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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18. Disable the Format Payments checkbox. 

19. Enable the Print Preliminary Register. 

20. If you want to print the register report, select a printer from the LOV in the Printer field. 

Example: 
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21. Select the OK button. 

If you want to review an on-line version of the report, goto task #22.  Otherwise, end of 
activity. 

22. From the menu bar, select View > Requests to review the status of your request. 

Result:  The Find Requests window is displayed 
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23. Select the Find button. 

Result:  The Requests window is displayed. 

 

24. Select the Refresh Data button to check on the status of the requests until the request lines 
complete with a status of normal. 

25. Highlight the Preliminary Register Report. 
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26. Select the View Output button. 

Result:  The Report - Request ID... window is displayed. 

 

27. Select Tools > Copy File from the menu bar. 

Result:  The Preliminary Register Report will be displayed in a browser window. 
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End of activity. 
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Marking Invoices for Cashier Pickup 

Page 30

Marking Invoices for Cashier Pickup

Remove the invoice from the payment batch
Place the invoice on “Cashier Payment” hold
Update the invoice payment method to check 
if possible.
You should follow existing NIH Policy on 
issuing payments from the Cashier’s Office.

3.  Modify Batch

US Treasury NIH Cashier
Cashier Hold

 
If the invoice is located in a payment batch, then you must remove the invoice from the batch 
and completely process the payment batch prior to applying the “Cashier Payment” hold and 
updating the payment method. 
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Invoices - Applying Holds to Invoices 

Purpose 

The purpose of this document is to describe how to apply manual holds to invoices.  An invoice 
that is on hold cannot be included in a payment batch.  The hold must be released prior to 
processing payment on that invoice. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window. 

2. Select the Find button. 
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Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice that you would like to place on hold by clicking in the line of the 
invoice. 

4. Select the Holds button. 

Result:  The Invoice Holds window is displayed. 
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5. In the Hold Name field, select a hold from the LOV.  

Result:  The Hold Reason field defaults. 

 

6. Save your work.   

7. Close the Invoice Holds window. 

Result:  The Invoices window is displayed.  The Holds field should display the hold. 
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End of activity. 
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Invoices - Updating an Invoice Payment Method 

Purpose 

The purpose of this document is to describe how to change the payment method on an invoice.  
Note that for some invoice types, you will be unable to change the payment method after the 
invoice has been validated. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window. 

2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed. 
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3. Place your cursor in the line of the invoice for which you want to change the payment 
method. 

4. In the Payment Method field, use the LOV to select the desired payment method. 

Note:  You may only update this field for invoices that are not paid or selected for a 
payment batch. 

Result:  The payment method is updated. 
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5. Save your work.   

End of activity. 
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Format Treasury Payment Batches 
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Format Treasury Payment Batches 

4.  Format BatchPayment batches should be 
formatted only when the payment 
batch contents have been reviewed
and finalized

Once this step is complete, the 
payment batch will be placed on the 
on the server

No changes are allowed to the 
payment batch after formatting

 
In this step, you are: 

    Formatting the payment batch file for Treasury to process 
    Placing the payment batch on the server to be transmitted to Treasury 

 
Note:  If you attempt to format a payment batch that contains zero negotiable payments, the 
format process will end in error.  You should cancel the batch if this occurs. 
 
Important!!!!! 
 
If the payment batch should be modified after it has been formatted, the payment batch 
must be cancelled and you must inform NMC and Treasury so that they can take necessary 
action to ensure that the payment batch is not processed.   
 
An email must be sent immediately to Saeed Latifian (NMC) with a copy going to Robert Miller 
(Treasury).  It must include the Payment Batch name, # of payments included, and the batch 
generation date. If this is not done before the batch is forwarded to Treasury, then Certifying 
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Officer must not certify batch when a confirmation is sent back to the Certifying Officer from 
Treasury. 
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Payments - Formatting a Payment Batch 

Purpose 

Formatting a payment batch creates the payment batch file and places that file on the server for 
the US Treasury to pick up for processing.  Once a payment batch is formatted, it cannot be 
modified.  If changes are required to a formatted payment, it must be cancelled and CIT and 
Treasury contacted immediately. 

Prior Activity 

Before completing this activity, the payment batch must have been created and built.  Refer to 
Create, Build and Select a Payment Batch [NAV1009A]  

Note:  If the payment batch window displays the batch you want to format, then skip Steps #1-7. 

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 

Result:  A caution window is displayed.   

2. Select the OK button. 

Result:  The Payment Batches window is displayed. 
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3. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

4. Enter the search criteria to locate the batch, such as the batch name. 

5. Press the Ctrl + F11 keys  

Result:   The batches meeting the search criteria are displayed. 

 

7. Highlight the batch(s) to be formatted. 

Note:  The Status of the batch must be "Built".  Also, the number of payments in the batch 
must be one or greater. 

8. Select the Actions... button. 

Result:  The Payment Batches Action window is displayed. 
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9. Confirm that the Format Payments check box is enabled. 

10. Select the OK button. 

Result:  A message box is displayed that asks if you want to perform AP/AR Netting. 

 

11. Select No. 

Result:  The concurrent request is submitted and a message box is displayed with the request 
ID number. 

12. Select the Requery Batch button to review the batch status and next step. 
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13. Review the Next Step field to ensure that there were no errors during formatting. 

If there were formatting errors, goto task# 14.  Otherwise, end of activity. 

14. Contact the NIH Help Desk. 

End of activity. 
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Confirming Treasury Payment Batches 
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Confirming Treasury Payment Batches

5.  Confirm BatchBefore you confirm a check payment batch, 
write down the value in the Negotiable 
Payments field in the Payment Batch window

You will be asked to enter range of 
payment documents

 
Confirming Treasury Payment Batches updates the AP Invoice information to indicate: 
•  The amount paid on the invoice 
•  The payment date 
•  The payment document number 
 
In addition, confirming the payment batch releases the payment document type to be used on 
future payment batches.  If this step is not completed, the new payment batches cannot be created 
using that document type. 
 
This step should not be confused with the Treasury certification step that is required in the ECS. 
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Payments - Confirming a Payment Batch 

Purpose 

The purpose of this document is to describe how to confirm a payment batch in Accounts 
Payable.  Confirming is the final step in processing a payment batch. This step updates the 
payment history of invoices paid in a payment batch, associates payment document numbers 
with the invoices and invoice payments, and releases the payment document for use on future 
batches. Also, the accounts payable period cannot be closed until all payment batches in progress 
are completed. 

Prior Activity 

Before completing this activity, the payment batch must have a status of Formatted, and the 
Next Step field must display Confirm.  

In addition, for check payment batches you will be required to enter the payment document 
range.  Before starting the confirmation process, write down the starting payment document 
number and number of negotiable payments in the batch. 

Note:  If the Payment Batch screen has not been closed after formatting the payment batch, the 
user may skip steps 1 - 7.  

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window 

Result:  An error message is displayed.   

2. Select the OK button. 
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Result:  The Payment Batches window is displayed. 

 

3. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

4. Enter the search criteria to locate the batch, such as the batch name. 

5. Press the Ctrl + F11 keys  

Result:   The batches meeting the search criteria are displayed. 

 

7. Highlight the batch(es) to be confirmed by placing your cursor in the lines of the batch. 

8. Select the Actions...1 button. 

Result:  The Payment Batches Action window is displayed. 
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9. Confirm that the Confirm Payment Batch and the Print Final Register checkboxes are 
enabled. 

10. Tab to the Printer field and select the appropriate printer from the LOV. 

Example:  Below is an example of a completed Payment Batch Actions window. 
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12. Select the OK button. 

If you are confirming a check payment batch, goto task #13. Otherwise, goto task #15. 

13. In the Status field, select Printed from the LOV. 

14. In the To field, enter the final check number. 

Hint:  To calculate the final check number, add the beginning check number to the number 
of negotiated payments in the batch and subtract 1. 

Goto task #16. 

15. Review the information displayed. 

Example:  The Confirm Payment Batch window is displayed. 
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16. Select the Confirm button. 

Result:  A message box is displayed that provides the request ID. 

17. Select the OK button. 

18. Select the Requery Batch button to confirm that the Status is Confirmed. 

Result:  The Status field displays Confirmed.  

 

End of activity. 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 82  

Final Payment Register 
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Final Payment Register

The final payment register report displays all payments included in a 
payment batch
The report should be 

Printed
Provided to the Certifying Officer for review prior to ECS certification
Filed

 
The final payment register must be used as support by the Certifying Officer when certifying the 
payment batches in the ECS. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 2:  Processing Payment Batches to Treasury 
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Certifying Treasury Payment Batches in ECS 
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Certifying Treasury Payment Batches in ECS

The Certi fying Officer should match the 
Treasury confirmation information with the 
Final Register Report before certifying the 
batch in the ECS.
Unless this certification is completed in the 
ECS, Treasury will not process the payment 
batch.  

NIH Certifying Officer 
Certifies Payment
Batch

Certify Payment 
Batches in ECS

 
NMC will continue to provide the OFM Travel Office with the treasury confirmation number, 
which is required for ECS confirmation.  This code will be available to NMC when the payment 
batch has been formatted. 
 
Note:  We recommend that before certifying the batch in the ECS, the certifying officer should 
confirm that the batch was fully processed in the NBS and that the totals match through the Final 
Payment Register report. 
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Canceling a Payment Batch 
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Canceling a Payment Batch

You may cancel a payment batch prior to 
completing the formatting stage

Includes payment batches in the built stage or 
those that completed in error during formatting
You should cancel a payment batch if zero 
invoices were selected for payment.

Canceling a payment batch
Releases the invoices in the batch, marking the 
invoices as available for future payment 
batches
Releases the payment document, allowing the 
document to be used on another payment 
batch

The status of the payment batch will change 
to “Cancelled”

CANCEL

 
Important!!!!! 
If the payment batch should be cancelled after it has been formatted, the payment batch 
must be cancelled and you must inform NMC and Treasury so that they can take necessary 
action to ensure that the payment batch is not processed.   
 
An email must be sent immediately to Saeed Latifian (NMC) with a copy going to Robert 
Miller (Treasury).  It must include the Payment Batch name, # of payments included, and 
the batch generation date. If this is not done before the batch is forwarded to Treasury, 
then Certifying Officer must not certify batch when a confirmation is sent back to the 
Certifying Officer  from Treasury. 
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Payments - Canceling a Payment Batch 

Purpose 

Canceling a payment batch cancels the existing the payment batch file, releases the document 
number for use on other batches, and releases the invoices contained in the file to be picked up in 
other batches. 

This action can be taken for a payment batch up to the point that the batch has been successfully 
formatted.   

Important:  If the payment batch should be modified after it has been formatted, the payment 
batch must be cancelled and you must inform CIT and Treasury so that they can take necessary 
action to ensure that the payment batch is not processed.   

An email must be sent immediately to Saeed Latifian (CIT) with a copy going to Robert Miller 
(Treasury).  It must include the Payment Batch name, # of payments included, and the batch 
generation date. If this is not done before the batch is forwarded to Treasury, then Certifying 
Officer must not certify batch when a confirmation is sent back to the Certifying Officer from 
Treasury. 

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window. 

2. Click OK. 

Result:  The Payment Batches window is displayed. 
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5. Press the F11 key to enter query mode. 

Note:  The fields will turn blue. 

6. Enter search criteria for the payment batch. 

Note:  The payment batch name can be entered using wild card characters in the Batch 
Name field. 

7. Press Ctrl + F11 to execute the query. 

Result:   The batches meeting the search criteria are displayed. 

 

8. Highlight the batch(s) to be cancelled. 

Note:  The Status of the file cannot be Formatted or Confirmed. 

9. Select the Actions... button. 
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Result:  The Payment Batches Action window is displayed. 

 

10. Deselect any boxes that are enabled. 

Result:  The Cancel Payment Batch option will be available. 

11. Enable the Cancel Payment Batch box. 

Example: 
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12. Select the OK button. 

Result:  A message box is displayed indicates you must requery the batch. 

 

13. Select OK. 

14. Select the Requery Batch button to review the batch status. 

Result:  The Status field displays the Cancelled status. 
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End of activity. 
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Confirming Treasury Payment Batches in Fed Admin 

Page 37

Confirming Treasury Payment Batches in Fed 
Admin

The following day, the OFM General Ledger 
Branch will receive the GOALs report for the 
payment batches paid by Treasury the day 
before.
The General Ledger Branch will confirm the 
payment batch in the Fed Admin module.  

OFM General Ledger
Branch Confirm Treasury 
Payment Batches

Review  Goals Report

Confirm Batch in Fed 
Admin
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Processing Returned Treasury Payments 
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Processing Returned Treasury Payments 

After this lesson you should know how to:

• Process travel-related payments to Treasury

Process returned and voided Treasury payments
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Roles and Responsibilities 
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Roles and Responsibilities 

Void the payment in Accounts Payable, entering the void schedule
number

Take appropriate action required to resolve the return

Update the invoice information, if necessary

Release the hold on the invoice once the problem has been 
resolved

Inform the NIH Payables User of the payments that have been 
returned and provide a return schedule number

Update the supplier address or bank information as requested 
from Traveler

NIH Payables User

OFM General Ledger Branch

OFM Government Accounting Branch
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Option 3:  Oracle Extension 
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Option 3:  Oracle ExtensionProcessing Returned Treasury Payments

OFM General Ledger
Branch Confirm Treasury 
Payment Batches

Review  Returned 
Payment Notif ication

Deliver returned 
payment notice to NIH 

Payables User

NIH Payables User
Processes 
Returned Payments

1.  Void Payment

2.  Research Payment

3.  Update Invoice

4.  Release Hold

 
Alternatively, the traveler may contact the OFM Travel Office if the payment was not received 
within the expected timeframe.  In this case, OFM would check the NBS to ensure that the 
payment was processed.  If so, OFM may request a check tracer be placed on the payment.  In 
the event that the check tracer indicates that the payment was returned to Treasury, you should 
follow the same process as when the General Ledger Branch provided you with a copy of the 
returned payment notifications. 
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Voiding a Payment 
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Voiding a Payment

Upon receipt of a returned payment 
notification from GL Branch or 
confirmation from the check tracer 
process, you must void the 
payment in Accounts Payable

The GL Branch should provide you 
with a return schedule number to 
enter on the payment.

1.  Void Payment

VOID
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Voiding a Payment 
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Voiding a Payment

When voiding the payment, 
the system allows you to 
choose one of three options 
for the invoice:

1.  Place the invoice on hold

2.  Cancel the invoice

3.  None

If voiding a payment due 
to a returned payment,  
you should place the 
invoice on Hold.

1.  Void Payment

 
When an invoice is being voided due to a banking or address error, we suggest that you place the 
invoice On Hold to allow for time to research the reason for the error. 
 
The hold name selected may be  
• Bank Research 
• Invoice Research 
• Address Research 
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Payments - Voiding a Payment 

Purpose 

The purpose of this document is to describe how to void a payment in Accounts Payable from 
the Invoice Workbench. 

 
NIH Payables User 
NIH Payables Cashier Office User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter your search criteria in the Find Invoices window. 

Note:  Use the invoice number if available. 

2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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3. Ensure that the invoice is accounted by looking at the Accounted field. 

If the Accounted field displays "Yes", goto task #7. Otherwise, goto task #4. 

4. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 

5. Enable the Create Accounting checkbox. 

Example:  Below is a sample enabled Create Accounting checkbox. 
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6. Select the OK button. 

7. Select the Payments button. 

Result:  The Payments window is displayed. 
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8. Select the Payment Overview button. 

Result:  The Payment Overview window is displayed. 

 

9. Select the Payments button. 

Result:  The Payments window is displayed. 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 101  

 

If the Accounted field contains "NO", goto task #10. Otherwise, goto task #13. 

10. Select the Actions button. 

Result:  The Payment Actions window is displayed. 
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11. Enable the Create Accounting checkbox. 

12. Select the OK button. 

Result:  The Payment window is displayed and the Accounted field displays "Yes" 
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13. Use the horizontal scroll bar to locate the Flexfield [] and place your cursor in the field. 

Result:  The Payment Information flexfield is displayed. 

 

14. Enter the return schedule number into the Voided Payments field. 

15. Select the OK button. 

Result:  The Payment Information flexfield closes. 

16. Select the Actions... button. 

Result:  The Payment Actions window is displayed. 
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17. Enable the check box Void. 

Result:  The current date defaults into the Date and GL Date fields. 

18. In the Invoice Action field, select the appropriate value from the drop down menu. 

If you selected Hold, goto task #19. Otherwise, goto task #21. 

19. Select Void Payment from the LOV in the Name field. 

Result:  The Reason field will populate automatically 
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20. Select the Hold button. 
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Example:  Below is a sample completed Actions window. 

 

21. Select the OK button. 

Result:  A message appears to confirm that you want to void this payment. 

22. Select the OK button. 

Result:  The payment is voided.  The status of the payment is updated to Voided. 
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23. Select the Actions button. 

Result:  The Payment Actions window will be displayed. 
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24. Enable the Create Accounting checkbox. 

Example:  Below is a sample enabled Create Accounting checkbox. 
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25. Select the OK button. 

Result:  You are returned to the Payments window. 
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End of activity. 
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Researching Return Reason 
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Researching Return Reason

The Travel Office should work 
with the traveler or travel planner 
to determine the corrective 
action needed and communicate 
with the appropriate individuals
You may search for the 
supplier’s address and bank 
information in the NBS (Refer to 
the Supplier Inquiry Section of 
this Student Guide)

2.  Research 
Payment

 
Changes to Traveler Bank Information 
If an update is needed to the bank information, the traveler should update the information at the 
source. 
 
Changes to Traveler Address Information 
If an update is needed to the individual’s address, then the travel planner should request the 
update be made in the appropriate source system:  NED, HRDB, or the NBS. 
 
Changes to Sponsor Bank and Address Information 
In the event that a sponsor payment was made to the incorrect bank or address information, 
update requests should be submitted to the Government Accounting department according to 
department policy.  Address updates should be submitted via the Govt Acctg mailbox.  Bank 
Information updates should be submitted via the Miscellaneous Vendor ACH Request Form. 
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Updating the Invoice Information 
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Updating the Invoice Information

Once the updates have been made to 
the bank or address information, you 
must update the invoice accordingly.
We suggest that you confirm the 
changes with the supplier record prior to 
moving to the next step (See Supplier 
Inquiry)

3.  Update Invoice

Problem 
Resolved
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Updating the Address Information on the Invoice 
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Updating the Address Information on the 
Invoice

The Supplier address information can 
be updated by selecting the LOV on the 
Supplier Site field.

3.  Update Invoice

 
Note:  The value in the Site field may not change depending upon how the updates were made to 
the address by Government Accounting.  However, you will be able to validate the supplier’s 
address within the Supplier table and on the Preliminary Payment Register Report. 
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Updating the Bank Information on the Invoice 
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Updating the Bank Information on the Invoice

The Supplier bank account information 
can be updated by selecting the 
Scheduled Payments button on the 
Invoices window.

3.  Update Invoice
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Invoices - Updating Banking Information on an Invoice 

Purpose 

The purpose of this document is to describe how to update the banking information on an AP 
Invoice in the event that changes were made to the information after the AP Invoice was created. 

 

NIH Payables User 

N > Invoices > Entry > Invoices 

Invoices 

 

1. Enter search criteria into the Find Invoices window. 

2. Select the Find button. 
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Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice on which you would like to update the payment information by 
placing your cursor in the line of the invoice. 

4. Select the Scheduled Payments button. 

Result:  The Scheduled Payments window is displayed. 
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5. Select the Remit-To Bank Account region tab. 

Result:  The bank-related fields are displayed. 
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6. In the Name field, use the LOV to populate the current primary bank account for the 
supplier. 

Example:  Below is a sample completed Bank Account region. 
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7. Save the changes 

8. Close the Scheduled Payments window. 

End of activity. 
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Releasing the Invoice Hold 
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Releasing the Invoice Hold

Once the problem causing the return 
has been resolved, the invoice must be 
released from hold in order to be 
processed.

4.  Release Hold

 
Once you release the hold from the invoice, ensure that the Status field indicates that it has been 
validated.  If not, validate the invoice on-line. 
 
Once an invoice has been released from hold and validated, it may be selected for the next 
payment batch. 
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Invoices - Releasing Holds from Invoices 

Purpose 

The purpose of this document is to describe how to release holds from invoices.  Only certain 
types of holds can be released according to this procedure, including the following: 

− Cashier Payment 
− Debit Memo 
− Invoice Research 
− Patient Recorded Pay 
− Reconciliation Process 
− Void Payment 

Other holds may be released by validating the invoice.  Refer to Validating Invoices On-Line 
[NAV1003A]. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window 
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2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice that you would like to release from hold. 

4. Select the Holds button. 

Result:  The Holds window is displayed. 
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Note:  If the hold can only be released through Validation, the Release Name and Release 
Reason fields will be grey. 

5. In the Release Name field, use the LOV to select an appropriate value. 

Result:  The Release Reason defaults. 

6. Save the record. 

Result:  The Release Date and Released By fields are populated. 
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7. Close the Holds window 

Result:  The hold on the invoice should be released. 

 

End of activity. 
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Invoices - Validating Invoices On Line 

Purpose 

The purpose of this document is to describe how to validate an invoice or group of invoices from 
the Invoices window. 

NIH Payables Cashier Office User 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the appropriate search criteria and select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Highlight invoices that you want to validate. 

3. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 
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4. Enable the Validate checkbox  

Example:  Below is a sample enabled validate checkbox. 
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5. Select OK. 

Result:  You are returned to the Invoices window. 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Processing Payment Batches to Treasury   
 Chapter 4 - Page 129  

 

 

Notes:   
− Refer to the Status and Holds fields to view the results of the validation program. 
− If the Status field displays "Needs Revalidation", view the holds that have been 

placed on the invoice. 

End of activity. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 3:  Processing Returned Payments 
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Lesson Summary 
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Lesson Summary

In this lesson, you learned how to:

• Process travel-related payment batches to Treasury

• Process returned and voided Treasury payments
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Travel-related Adjustments in 
Accounts Payable 
Chapter 5 
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Accounts Payable Travel-Related Adjustments 

Accounts Payable Travel-Related Adjustments

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 
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Lesson Objectives 

After this lesson, you will know how to:

• Review the adjustment request and determine the appropriate 
method to correct it

• Enter a debit memo

• Enter an invoice to refund a sponsor

• Cancel an invoice

• Void a payment
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Option 3:  Oracle Extension 
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Option 3:  Oracle ExtensionAP Invoice Adjustment Process

OFM Takes 
Corrective Action

1.  Perform 
adjustments in 

financial modules

2.  Document and file

IC Informs NMC or OFM 
of error on travel 
document

IC contacts OFM

NMC contacts OFM and 
requests corrective action

IC provides OFM w ith 
correct information

 
Errors may be identified by the IC, OFM, or the NIH Management Center 
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Determining Appropriate Corrective Action 
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Determining Appropriate Corrective Action 

After this lesson, you will know how to:

Review the adjustment request and determine the 
appropriate method to correct it

• Enter a debit memo in AP

• Enter an invoice to refund a sponsor

• Cancel an AP Invoice
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Determining Appropriate Corrective Action 
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Determining Appropriate Corrective Action

OFM will receive requests for corrective 
action from the ICs or the NIH Help Desk.
Eight scenarios have been identified as 
the most probable adjustment scenarios
Use the eight scenarios listed in the 
upcoming slides to determine the 
appropriate corrective action
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AP Adjustment Scenarios 
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AP Adjustment Scenarios

Scenario 1:  An Expense was included on the voucher that should be 
removed

Enter a debit memo in AP
Record the refund when payment is received
Enter an AP Invoice if a Sponsor refund is requested

Scenario 2:  Incorrect Accounting was used on the Voucher
• Request a manual journal voucher in GL

Scenario 3:  Traveler reported a direct expense as sponsored in-cash on 
the travel voucher

Request a manual journal voucher in GL

 
Each scenario may require an AR adjustment if it affects a sponsored travel in-cash expense. 
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AP Adjustment Scenarios 

Page 6

AP Adjustment Scenarios

Scenario 4:  Traveler reported a sponsored in-cash expense to a 
direct project on the travel voucher

Request a manual journal voucher in GL
Scenario 5:  Traveler reported a sponsored in-kind expense as a 
sponsored in-cash expense on the travel voucher

Enter a debit memo in AP
Enter an AP Invoice if a Sponsor refund is requested

Scenario 6:  Traveler reported a sponsored in-cash expense as a 
sponsored in-kind expense on the travel voucher

No AP action required
The Travel Planner enters a new voucher for the in-cash amount previously 
reported in error
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AP Adjustment Scenarios 
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AP Adjustment Scenarios

Scenario 7:  Sponsor pays less than expected
Enter a manual journal voucher in GL, if the invoice is posted

Scenario 8:  Sponsor pays more than expected
Enter an AP Invoice if a Sponsor refund is requested
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Inform IC of Adjustments 
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Inform IC of Adjustments

Once the corrective action has been 
determined, the OFM should inform the IC of 
the steps that will be taken.
In addition, if the IC must take corrective 
action in the NBS Travel System, provide the 
IC with explicit directions as to the information 
that should be entered.
All communications with the ICs should 
be done in writing.
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Entering a Debit Memo 
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Entering a Debit Memo 

After this lesson, you will know how to:

• Review the adjustment request and determine the appropriate 
method to correct it

Enter a debit memo

• Enter an invoice to refund a sponsor

• Cancel an invoice

 



 

Travel-related Adjustments in Accounts Payable   
 Chapter 5 - Page 12  

Entering a Debit Memo 
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Entering a Debit Memo 

A debit memo in AP indicates that a supplier 
owes the NIH money. 

The following Scenarios may require an AP 
Debit Memo:

• Scenario 1:  An Expense was included on the 
voucher that should be removed

• Scenario 5:  Traveler reported a sponsored in-
kind expense as a sponsored in-cash expense 
on the travel voucher

In addition, the NIH Cashier may notify the 
Travel Office of a refund for which a debit 
memo is required, but not yet entered.

1.  Perform 
adjustments in 

financial modules
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Entering a Debit Memo 
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Entering a Debit Memo 

Follow the steps below to enter a Debit Memo: 1.  Perform 
adjustments in 

financial modules

Step 1: Determine the correct accounting information based 
upon the Distributions of the original invoice

Step 2: Enter a Debit Memo Invoice Batch

• Invoice Type = Debit Memo

• Invoice Number = TRx-DM ADJ

• Transaction Code = B107x, where X is the fund type

• Invoice Amount entered as a negative

• Accounting information taken from the original invoice and

verified with Requestor

Step 3: Place Debit Memos on Hold

 
When placing a debit memo on hold, use the hold reason “Debit Memo”. 
 
Fund Suffixes: 
Management Fund = M 
IC Reimbursable = E 
Direct = D 
CRADA = C 
Service and Supply Fund = O 
Gift = O 
Royalty = O 
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Invoices - Entering Debit Memos 

Purpose 

The purpose of this document is to describe how to enter debit memo invoices into the NBS.  

Before you begin 

Before you begin, the following information must be available: 
− Supplier Name 
− Supplier Site 
− Invoice Number 
− Invoice Date 
− Amount 
− Payment Terms (if different from default) 
− Accounting Information: 

− Project Number 
− Expenditure Type 
− Expenditure Date 
− Transaction Code based on Fund Value 

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Invoice Batches 

 

1. Enter a unique name for the invoice batch in the Batch Name field. 

Note:  The naming convention for this field should be followed.   

2. Tab to the Control Count field and enter the number of invoices in the batch. 
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Note:  This field is optional. 

3. Tab to the Control Amount field and enter the total dollar value of the invoices in the 
batch. 

Note:  This field is optional. 

4. Save your work. 

Example:  Below is a sample completed Invoice Batches window. 

 

5. Select the Invoices button. 

Result:  The Enter Transaction Events window is displayed. 

 

6. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 
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Note:  The transaction code will not be entered at the invoice header level, but will rather be 
entered at the distribution line level. 

Result:  A Caution window appears. 

 

7. Select the OK button. 

Result:  The Invoices window is displayed. 

 

8. In the Type field, select Debit Memo from the LOV.   

9. Tab to the Supplier field. 

Result:  A note is displayed. 
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10. Select the OK button. 

11. Select the appropriate supplier name from the LOV. 

Result:  The Supplier Number field defaults. 

12. Enter the remaining invoice information based upon the table below: 

Note:  If a field is not referenced in this table, it is not required.  Do not complete any fields 
that are not listed below. 

 
Field Description 

Site Accept default value or select the appropriate site from the 
LOV 

Invoice Date Enter the date of the debit memo. 
Invoice Number Enter a unique number based upon the approved invoice 

naming conventions. 
Invoice Amount Enter the amount of the debit memo.  This value must be 

negative. 
Terms Date Defaults to the current date. 
Terms Defaults from the supplier record. 

If necessary, use the LOV to select a different term. 
Payment Method Defaults from the supplier record.  If necessary, use the LOV 

to select a different payment method.  
Pay Group Defaults from the supplier record. 

Example:  Below is a sample completed debit memo invoice line. 
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13. Select the Distributions button. 

Result:  The Distributions window is displayed. 
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14. Enter the amount of the debit memo distribution line in the Amount field.  This value must 
be negative. 

If you have the project, expenditure type, and expenditure date information, goto task #16. 
Otherwise, goto task #15. 

15. Enter the account information in the Account field. 

Goto task #17. 

16. Enter the following information in the first available distribution line: 

 
Field Description 

Project Enter the Project number 
Task Select 1 from the LOV 
Expenditure Type Select the Expenditure Type from the LOV 
Expenditure Item Date Enter the Expenditure Date 
Expenditure Organization Select HN from the LOV 

17. Scroll to the USSGL Transaction Code field, and select the appropriate value from the 
LOV.   

Note:  The appropriate value should be B107 followed by the correct fund value suffix.  For 
example, if the original invoice contained a value of B302D, then for the debit memo, the 
appropriate value would be B107D.  If the original invoice was a prepayment, enter B107. 
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Example:  Below is a sample completed distributions window. 

 

18. Close the Distributions window. 

Result:  You are returned to the Invoices window. 
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If there are additional debit memos to enter, goto task #19. Otherwise, goto task #20. 

19. Place your cursor in the next line. 

Goto task #8. 

20. Close the Invoices window. 

Result:  You are returned to the Invoice Batches window. 

 

21. Review the Batch Control Total and Actual Total fields.  
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End of activity.  
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Invoices - Applying Holds to Invoices 

Purpose 

The purpose of this document is to describe how to apply manual holds to invoices.  An invoice 
that is on hold cannot be included in a payment batch.  The hold must be released prior to 
processing payment on that invoice. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window. 

2. Select the Find button. 
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Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice that you would like to place on hold by clicking in the line of the 
invoice. 

4. Select the Holds button. 

Result:  The Invoice Holds window is displayed. 
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5. In the Hold Name field, select a hold from the LOV.  

Result:  The Hold Reason field defaults. 

 

6. Save your work.   

7. Close the Invoice Holds window. 

Result:  The Invoices window is displayed.  The Holds field should display the hold. 
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End of activity. 
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Practice Lab  

Page 12

Practice Lab

Lab Time

 
Complete Lab:  Entering Debit Memo Invoice Batches 
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Entering an Invoice to Refund a Sponsor 

Page 13

Entering an Invoice to Refund a Sponsor 

After this lesson, you will know how to:

• Review the adjustment request and determine the appropriate 
method to correct it

• Enter a debit memo

Enter an invoice to refund a sponsor
• Cancel an invoice

• Void a Payment
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Entering an Invoice to Refund a Sponsor 
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Entering an Invoice to Refund a Sponsor

The following Scenarios may require a refund to a sponsor:

• Scenario 1:  An Expense was included on the voucher that should be 
removed

• Scenario 5:  Traveler reported a sponsored in-kind expense as a 
sponsored in-cash expenses on the travel voucher

• Scenario 8:  Sponsor pays more than expected

OFM may refund money to sponsors for 
overpayment.  The OFM Travel Office will be 
requested to make such payments by the 
department responsible for the AR tasks.
Before a sponsor refund payment can be 
processed, the sponsor must be included in 
the Supplier Table by the Government 
Accounting Department.

1.  Perform 
adjustments in 

financial modules
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AR Group Requests New Suppliers 
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AR Group Requests New Suppliers

The AR group is responsible 
for requesting that the sponsor 
be added to the supplier table.
Government Accounting must 
receive the following 
information:

Name of the Supplier
Supplier Address
Supplier Taxpayer ID
ACH Information
Supplier Contacts (optional)

Supplier Setup Request

Please set up the following
sponsor as a supplier.

The NIH will refund money to this 
organization as a result of 
overpayment.

Name: Pew Charitable Trusts
Tax ID : 253652363
Address: 1254 Lincoln Ave

Chicago, IL 45256

ACH submitted
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Entering an Invoice for a Sponsor Refund 
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Entering an Invoice for a Sponsor Refund 

Follow the steps below to enter a Sponsor Refund 
Invoice Batch:

1.  Perform 
adjustments in 

financial modules

Step 1: Enter a Standard Invoice Batch

• Invoice Type = Standard

• Transaction Code = NONE

• Invoice Amount entered as a positive

• Accounting Information Provided by Requesting AR Group

Step 2: Validate the Invoice Batch

Step 3: Create Accounting for the Invoice Batch
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Invoices - Entering Invoice Batches 

Purpose 

The purpose of this document is to describe how to manually enter invoices into the NBS.  All 
manual invoices must be entered into NBS in batches.  Invoices that are entered manually will 
require the user to indicate the correct account code distribution, project, and task information.  
Once the invoice batch is entered, it will be necessary to validate and create accounting for the 
invoice as well.  Refer to Validating an Invoice On-Line [NAV1003A] and Creating Accounting 
for Invoices On-Line [NAV1006A]. 

Before you begin 

Before you begin, the following information must be available: 
− Supplier Name 
− Supplier Site 
− Invoice Number 
− Invoice Date 
− Payment Terms 
− Payment Method 
− Project Number 
− Expenditure Type 
− Expenditure Date 
− Transaction Code based on Fund Value 

 

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Invoice Batches 
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1. Enter a unique name for the invoice batch in the Batch Name field. 

Note:  The naming convention for this field should be followed.   

2. Tab to the Control Count field and enter the number of invoices in the batch. 

3. Tab to the Control Amount field and enter the total dollar value of the invoices in the 
batch. 

4. Save your work. 

Example:  Below is a sample completed Invoice Batches window. 

 

5. Select the Invoices button. 

Result:  The Enter Transaction Events window is displayed. 
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If a transaction code should be entered, goto task #7. Otherwise, goto task #6. 

6. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 

Result:  A Caution window appears. 

Goto task #8. 

7. In the Transaction Event field, select the appropriate transaction code from the LOV.  

Result:  The Transaction Code field value defaults. 

8. Select the OK button. 

Result:  The Invoices window is displayed. 

 

9. In the Type field, select the appropriate type of invoice from the LOV.   

10. Tab to the Supplier field and select the appropriate supplier name from the LOV. 

Result:  The Supplier Number field defaults. 

Note:  You may receive a message indicating that a prepayment is available. 
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11. Enter the remaining invoice information based upon the table below: 

Note:  If a field is not referenced in this table, it is not required.  Do not complete any fields 
that are not listed below. 

 
Field Description 

Site Accept default value or select the appropriate site from the 
LOV 

Invoice Date Enter the invoice date 
Invoice Number Enter a unique invoice number 
Invoice Currency Defaults to USD 
Invoice Amount Enter the amount of the invoice 
Project Enter the Project information  
Task Select the Task information from the LOV 
Expenditure Type Select the Expenditure Type from the LOV 
Expenditure Item Date Enter the Expenditure Date 
Expenditure Organization Select the Expenditure Org from the LOV 
GL Date Defaults.  Do not change 
Payment Currency Defaults to USD.  Do not change 
Description Enter a description of the invoice. 
Payment Rate Date Defaults to current date.  Do not change 
Transaction Code Defaults from value entered in Enter Transaction Code 

window.  Do not change 
Terms Date Defaults to the current date. 
Terms Defaults from value entered in Invoice Batches window. 

If necessary, use the LOV to select a different term. 
Payment Method Defaults from what is entered on the Invoice Batches 

window.  If necessary, use the LOV to select a different 
payment method.  

Pay Group Defaults from value entered in Invoice Batches window 

Example:  Below is a sample completed invoice line. 
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If you want to apply a prepayment, goto task #12. Otherwise, goto task #19. 

12. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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13. Enable the Apply/Unapply Prepayment checkbox and select the OK button. 

Result:  The Apply/Unapply Prepayment window is displayed.  The available prepayments 
are displayed in the upper portion of the window. 
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14. Enable the Apply checkbox on those prepayment lines you want applied to the invoice. 

15. Enable the Prepayment on Invoice checkbox. 

16. Update the Amount To Apply field as necessary. 

Example:  Below is a sample completed window. 
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17. Select the Apply/Unapply button. 

Result:  The applied prepayment is displayed in the Existing Prepayment Applications 
block. 
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18. Close the Apply/Unapply Prepayments window. 

Result:  You are returned to the Invoices window. 
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If the invoice total matches the distribution total, end of activity. Otherwise, goto task #19. 

19. Select the Distributions button. 

Result:  The Distributions window is displayed. 



 

Travel-related Adjustments in Accounts Payable   
 Chapter 5 - Page 43  

 

20. Enter the following information in the first available distribution line: 

 
Field Description 

Amount Enter the amount that will be charged to the accounting 
information for that line. 
Note:  If entering a Debit Memo or Credit Memo, the amount 
must be entered as a negative. 

Project Enter the Project number 
Task Select 1 from the LOV 
Expenditure Type Select the Expenditure Type from the LOV 
Expenditure Item Date Enter the Expenditure Date 
Expenditure Organization Select HN from the LOV 

Notes:   
− If the Project, Task, Expenditure Type, Expenditure Item Date, and 

Expenditure Organization fields were not completed in the Invoice window, they 
must be completed in the Distributions window. 

− The total amount for all lines should equal the invoice total displayed in the top 
right hand corner of the screen. 

Note:  Below is a sample completed distributions window. 
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If the Invoice Total matches the Distribution Total, goto task #21. Otherwise, goto task #20. 

21. Close the Distributions window. 

Result:  You are returned to the Invoices window. 
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If there are additional invoices to enter, goto task #22. Otherwise, goto task #23. 

22. Place your cursor in the next line. 

Goto task #7. 

23. Close the Invoices window. 

Result:  You are returned to the Invoice Batches window. 

24. Review the Batch Control Total and Actual Total fields.  

End of activity.  
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Invoices - Validating an Invoice Batch On-Line 

Purpose 

The purpose of this document is to describe how to validate an invoice batch from the Invoice 
Batches window.  An invoice batch must be validated in order to be eligible for payment.  
Invoices that do not pass validation will be put on hold and will require revalidation in order to 
be released for payment. 

If you have not exited the invoice batches window after entering an invoice batch, you may skip 
steps 1 - 3. 

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Find Invoice Batches 

 

1. Press the F11 key to enter query mode. 

Result:  Your fields turn blue. 

2. Enter your search criteria to locate the invoice batch you want to validate. 

3. Pres the Ctrl + F11 keys to execute the query. 

Result:  The query results are displayed in the Invoice Batches window. 
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4. Select the Validate button. 

Result:  A caution message appears to confirm that you want to validate the invoice batch. 

 

5. Select the OK button. 

Result:  A message is displayed that indicates the concurrent request number. 

 

6. Select the OK button. 

7. From the menu bar, select View > Requests. 

Result:  The Find Requests window is displayed. 
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8. Select the Find button. 

Result:  The Requests window is displayed. 
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9. Select the Refresh Data button until the Invoice Validation program completes. 

Note:  If the program completes in error, contact the NIH Help Desk. 

End of activity. 
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Invoices - Creating Accounting for Invoice Batches On-Line 

Purpose 

The purpose of this document is to describe how to create the accounting transactions for 
invoices batches on-line.  This process is required prior to creating payments for the invoices.  

Before you begin 

Before the accounting can be created for an invoice batch on-line, the invoice batch must be 
validated.   

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Invoice Batches 

 

1. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

2. Enter your search criteria. 

3. Press the Ctrl + F11 keys to execute the query. 

Result:  The query results are displayed in the Invoice Batches window. 
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4. Select the Create Accounting button. 

Result:  A caution message appears to confirm that you want to create accounting for the 
invoice batch. 

 

5. Select the OK button. 

6. From the menu bar, select View > Requests. 

Result:  The Find Requests window is displayed. 
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7. Select the Find button. 

Result:  The Requests window is displayed. 
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8. Select the Refresh Data button until the Payables Accounting Process completes. 

Note:  If the program completes in error, contact the NIH Help Desk. 

End of activity. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Entering Sponsor Refund Invoice Batches 
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Canceling an AP Invoice 
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Canceling an AP Invoice 

After this lesson, you will know how to:

• Review the adjustment request and determine the appropriate 
method to correct it

• Enter a debit memo 

• Enter an invoice to refund a sponsor

Cancel an invoice

• Void a payment
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Canceling an AP Invoice 

Page 19

Canceling an AP Invoice

Invoices may be cancelled in Accounts Payable in the event that the 
invoice should not be paid now or in the future.
When you cancel an invoice, it remains visible in the Invoice 
workbench, but has the status of “Cancelled”

 
Notes:   
• You cannot cancel an invoice that has been matched against a final closed purchase order.  

In this case, you must contact the NIH Help Desk to cancel the invoice.   
• If you cancel an invoice, you should inform the NIH Help Desk so that the outstanding 

obligation can also be cancelled. 
• If you cancel an invoice in AP, you should verify that a corresponding invoice does not 

exist in AR.  If so, you must contact the travel planner to determine if an adjustment if any 
is required in AR. 
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Invoices - Canceling an Invoice 

Purpose 

The purpose of this document is to describe how to cancel invoices.   

Before you begin 

Before you begin, ensure that the invoice 
− has not had a prepayment applied to it.  If so, you must first unapply the prepayment 

before canceling the invoice. 
− has not  been matched to permanently closed purchase orders. 

 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window 

2. Select the Find button. 
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Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice(s) that you would like to cancel. 

4. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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5. Enable the Cancel Invoices checkbox. 

Example:  Below is a sample completed Invoice Actions window. 
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6. Select the OK button. 

Result:  A Caution window is displayed. 

  

Important:  Once you have cancelled an invoice, it cannot be undone. 

7. Select the OK button. 

Result:  The invoice is cancelled and is reflected in the Status field. 
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End of activity. 
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Canceling an AP Invoice 

Page 20

Canceling an AP Invoice

When an invoice is canceled, we recommend using the Attachments
feature to record the written request to cancel the invoice.
Attaching the back up documentation to cancelled invoices will help 
with future research.

 
Refer to the job aid on attachments. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Canceling AP Invoices 
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Voiding a payment 
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Voiding a payment 

After this lesson, you will know how to:

• Review the adjustment request and determine the appropriate 
method to correct it

• Enter a debit memo 

• Enter an invoice to refund a sponsor

• Cancel an invoice

Void a payment
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Voiding a Payment 
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Voiding a Payment

You may be required to void a
payment due to:

Incorrect Transaction Code on the 
payment batch

Invoice generated incorrectly from 
the NBS Travel System VOID

 
Follow the instruction on the next slide to correct a payment with the incorrect transaction code. 
 
If a payment should be voided due to the incorrect generation of an invoice, you should work 
with the NMC to resolve the issue. 
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Voiding a Payment 

Page 24

Voiding a Payment

When voiding the payment, 
the system allows you to 
choose one of three options 
for the invoice:

1.  Place the invoice on hold

2.  Cancel the invoice

3.  None

You should select the 
correct option based upon 
the situation.

 
When an invoice is being voided due to a banking or address error, we suggest that you place the 
invoice On Hold to allow for time to research the reason for the error.  The hold name selected 
may be Bank Research, Invoice Research, or Address Research. 
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Payments - Voiding a Payment 

Purpose 

The purpose of this document is to describe how to void a payment in Accounts Payable from 
the Invoice Workbench. 

 
NIH Payables User 
NIH Payables Cashier Office User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter your search criteria in the Find Invoices window. 

Note:  Use the invoice number if available. 

2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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3. Ensure that the invoice is accounted by looking at the Accounted field. 

If the Accounted field displays "Yes", goto task #7. Otherwise, goto task #4. 

4. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 

5. Enable the Create Accounting checkbox. 

Example:  Below is a sample enabled Create Accounting checkbox. 
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6. Select the OK button. 

7. Select the Payments button. 

Result:  The Payments window is displayed. 
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8. Select the Payment Overview button. 

Result:  The Payment Overview window is displayed. 

 

9. Select the Payments button. 

Result:  The Payments window is displayed. 
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If the Accounted field contains "NO", goto task #10. Otherwise, goto task #13. 

10. Select the Actions button. 

Result:  The Payment Actions window is displayed. 
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11. Enable the Create Accounting checkbox. 

12. Select the OK button. 

Result:  The Payment window is displayed and the Accounted field displays "Yes" 
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13. Use the horizontal scroll bar to locate the Flexfield [] and place your cursor in the field. 

Result:  The Payment Information flexfield is displayed. 

 

14. Enter the return schedule number into the Voided Payments field. 

15. Select the OK button. 

Result:  The Payment Information flexfield closes. 

16. Select the Actions... button. 

Result:  The Payment Actions window is displayed. 
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17. Enable the check box Void. 

Result:  The current date defaults into the Date and GL Date fields. 

18. In the Invoice Action field, select the appropriate value from the drop down menu. 

If you selected Hold, goto task #19. Otherwise, goto task #21. 

19. Select Void Payment from the LOV in the Name field. 

Result:  The Reason field will populate automatically 
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20. Select the Hold button. 
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Example:  Below is a sample completed Actions window. 

 

21. Select the OK button. 

Result:  A message appears to confirm that you want to void this payment. 

22. Select the OK button. 

Result:  The payment is voided.  The status of the payment is updated to Voided. 
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23. Select the Actions button. 

Result:  The Payment Actions window will be displayed. 
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24. Enable the Create Accounting checkbox. 

Example:  Below is a sample enabled Create Accounting checkbox. 
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25. Select the OK button. 

Result:  You are returned to the Payments window. 
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End of activity. 
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Option 3:  Oracle Extension 
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Option 3:  Oracle ExtensionHow should I correct the Transaction Code on 
a Payment to Treasury?

NIH Payables User Creates A Recorded 
Payment Batch for Single Invoice

Create, Build and Select Batch
Transaction Event = Use correct TC

Pay ment Batch Name = Original +TCADJ
Supplier Name = Payee Name

Pay Group = Appropriate Pay Group
Document = Recorded

Review Batch
Ensure that the batch contains the single invoice

Modify Batch
Remove any invoices that should not be in the batch

Format Batch

Confirm Batch

NIH Payables User 
Void Payment With 
Incorrect TC

Void Payment
Search for invoice based 

upon the Preliminary 
Register Report and Void 

the payment.

1

2

3

4

5

1
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Voiding Payments 
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Lesson Summary 
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Lesson Summary

After this lesson you learned how to:

• Review the adjustment request and determine the appropriate 
method to correct it

• Enter a debit memo

• Enter an invoice to refund a sponsor

• Cancel an invoice

• Void a payment
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Debit Memos and Travel 
Refunds 
Chapter 6 
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Processing Debit Memos and Refunds 

Processing Debit Memos and Refunds

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 
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Lesson Objectives 

After this lesson you should know how to:

• Describe the different types of debit memos

• Clear outstanding prepayments 

• Perform monthly maintenance of debit memos
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Types of Debit Memos 
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Types of Debit Memos

After this lesson you should know how to:

Describe the different types of debit memos

• Clear outstanding prepayments 

• Perform monthly maintenance of debit memos
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Refunds of Excess Travel Advances or Expenses 
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Refunds of Excess Travel Advances or 
Expenses 

In the event that a person is paid too much, Accounts Payable will be 
used to record the amount due to the NIH and the payments that have 
been received.

NIH
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Use of Debit Memos 

Page 4

Use of Debit Memos

In Accounts Payable, debit memos indicate that the supplier owes the 
NIH a refund.

 



 

Debit Memos and Travel Refunds   
 Chapter 6 - Page 7  

Accounts Payable Invoices and Payments 
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Accounts Payable Invoices and Payments

US 
Treasury

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices and Debit 
Memos imported
f rom Open Interf ace

• Inv oice batches 
created f or pay ment

• Inv oices are prepared 
f or pay ment

• Pay ment batches are 
generated f or Treasury

• Pay ments and
Refunds are 
recorded by Cashier

• Pay ments are 
recorded f or GTA 
Reconciliation

Cash 
Management

• Pay ments are 
reconciled
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Travel Refund Types 

Page 6

Travel Refund Types

1. Travel Advance Refunds
Debit Memo automatically created from the NBS Travel System if the 
amount of the final travel voucher is less than the amount of the 
prepayment
Outstanding prepayment exists for travel advances issued at the time of 
travel authorization
Naming convention is TRx-DM

2. Travel Refunds
Debit memos manually created by the travel office for the amount due 
back from the traveler as a result of overpayment of advance or expenses
Prepayments may or may not exist for these types of refunds
Naming convention is TRx-DM ADJ
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Debit Memo for Travel Advance Refunds 
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Debit Memo for Travel Advance Refunds

Debit Memos are automatically created from the NBS Travel System in 
the event that a traveler receives an advance that is greater that the 
amount of their final voucher.

Example:
Estimated out of pocket expenses =  $1000

Travel Advance = $800
Final Voucher Amount (out-of pocket only) = $600

Traveler owes NIH = $200

Debit memo is automatically created in AP for $200.00
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Debit Memo for Travel Refund 
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Debit Memo for Travel Refund

Debit Memos are manually created by the NIH Travel Office in the 
event that the traveler was overpaid for advances or expenses 

Travel Planner creates two travel documents for the same trip
Travel Planner indicates a GTA expense or Sponsored In-Kind is 
reimbursed to the traveler
Travel expense is included in the voucher that is larger than what the 
traveler actually spent.

The creation of the manual debit memo is covered in the Chapter on 
“Accounts Payable Adjustments” in this Student Guide
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Debit Memo Refund Process Overview 
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Debit Memo Refund Process Overview

Debit memos can be refunded in two ways:

The traveler presents a check payable to the 
NIH to the Cashier 

The debit memo amount is subtracted from a 
future payment to the traveler 

NIH Cashier

U.S. Treasury

 
In order to give the traveler time to submit the refund to the cashier, the debit memo is placed on 
hold, which prevents the debit memo amount from be deducted from future invoice payments. 
 
However, if the traveler does not submit the refund to the cashier, the NIH Travel Office may 
release the hold and validate the debit memo so that it can be deducted from future invoice 
payments. 
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Clearing Outstanding Prepayments 
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Clearing Outstanding Prepayments

After this lesson you should know how to:

• Describe the different types of debit memos

Clear outstanding prepayments 

• Perform monthly maintenance of debit memos
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Travel Refunds Paid to Cashier 
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Payment

Travel Refunds Paid to Cashier

Patient and Foreign 
Travelers

Traveler

Payment

NBS Accounts 
Payable

NIH Cashier

TMC

U.S. Treasury

Travel Information

Oracle
AP

Invoices and 
Debit Memos

ACH and Check 
Payment Requests

GTA 
Payments

Refunds

Travel
Manager

Refunds

The flow of travel refunds to Cashier is emphasized.

Cashier  Payment Requests 
and Debit Memos
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Option 3:  Oracle ExtensionDebit Memo Process When Traveler Presents 
Refund to the Cashier

Traveler Presents 
Refund to Cashier

1.  Locate the Debit Memo

2. Record the Refund

3. Generate Schedule of 
Collections Report

4. Deposit the Refund

5. Provide Schedule of 
Collections report to 

Travel Office

Travel Office 
Clears Prepayments

1.  Determine if Unapplied 
Prepayment Exists

2. Enter Invoice to Clear 
Prepayment

 
The Schedule of Collections report is generally created twice a week. 
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Identifying Refund Type 
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Identifying Refund Type

The Cashier’s office will provide the NIH Travel Office with a copy of 
the Schedule of Collections report on a bi-weekly basis that lists the 
travel advance refunds received
The report contains the invoice number for which the refund was 
received
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Travel Refunds Paid to Cashier 
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Travel Refunds Paid to Cashier

The NIH Travel Office must take the AP 
Schedule of Collections Report and determine 
which refunds relate to travel advances.
The report contains the invoice number for which 
the refund was received.

1.  Determine if Unapplied 
Prepayment Exists

Unapplied 
Prepayments Exist

Unapplied 
Prepayments May 

Exist

 
For travel advance refunds, an unapplied prepayment exists. 
For travel refunds, an unapplied prepayment may exist.  You must search for prepayments. 
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Travel Refunds Paid to Cashier 
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Travel Refunds Paid to Cashier

Use the NIH Schedule of Collections report to 
locate the travel refunds containing ADJ in the 
invoice number.
Use the base number to search for existing 
prepayments in the system.

1.  Determine if Unapplied 
Prepayment Exists

 
In the Invoice Number field, enter the base travel number followed by a %. 
In the Invoice Type field, select Prepayment. 
 
If no records matched your search, there is no prepayment that requires clearing for that debit 
memo. 
 
If records matched your search, review the status of the prepayment.  If it is Fully Applied, you 
do not need to clear the prepayment.  If it is Partially Applied, then you do need to clear the 
prepayment. 
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Clearing Prepayments in Accounts Payable 
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Clearing Prepayments in Accounts Payable

This step applies to 
Travel Advance Refunds 
Travel Refunds with Unapplied Prepayments

Clearing prepayments in Accounts Payable 
is performed by

Gathering the accounting information from 
the original prepayment
Entering a single line invoice for the amount 
of the refund
Apply the prepayment to the invoice

By applying the prepayment to the invoice, 
the invoice will be marked as paid

2. Enter Invoice to Clear 
Prepayment

 
Refer to the Naming Convention document for the appropriate Invoice Batch Name and Invoice 
Name conventions. 
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Invoices - Entering Invoice Batches to Clear Prepayments 

Purpose 

The purpose of this document is to describe how to enter invoices to clear outstanding 
prepayments.   

Before you begin 

Before you begin, the following information must be available: 
− Supplier Name 
− Original prepayment invoice number 
− Accounting information from the original prepayment invoice 
− Amount of the refund 

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Invoice Batches 

 

1. Enter a unique name for the invoice batch in the Batch Name field. 

Note:  The naming convention for this field should be followed.   

2. Tab to the Control Count field and enter the number of invoices in the batch. 

Note:  This is an optional field. 

3. Tab to the Control Amount field and enter the total dollar value of the invoices in the 
batch. 

Note:  This is an optional field. 
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4. Save your work. 

Example:  Below is a sample completed Invoice Batches window. 

 

5. Select the Invoices button. 

Result:  The Enter Transaction Events window is displayed. 

 

6. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 

Result:  A Caution window appears. 

7. Select the OK button. 

Result:  The Invoices window is displayed. 
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8. Tab to the Supplier field and select the appropriate supplier name from the LOV. 

Result:  The Supplier Number field defaults. 

Note:  You will receive a message indicating that a prepayment is available. 

 

9. Enter the remaining invoice information based upon the table below: 

Note:  If a field is not referenced in this table, it is not required.  Do not complete any fields 
that are not listed below. 
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Field Description 
Site Accept default value or select the appropriate site from the 

LOV 
Invoice Date Enter the invoice date 
Invoice Number Enter a unique invoice number based upon the appropriate 

naming convention 
Invoice Currency Defaults to USD 
Invoice Amount Enter the amount of the invoice 
GL Date Defaults.  Do not change 
Terms Date Enter today's date 
Terms Defaults from the supplier record. If necessary, use the LOV 

to select different terms. 
Payment Method Defaults from the supplier record.  If necessary, use the LOV 

to select a different payment method.  

Example:  Below is a sample completed invoice line. 

 

10. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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11. Enable the Apply/Unapply Prepayment checkbox and select the OK button. 

Result:  The Apply/Unapply Prepayment window is displayed.  The available prepayments 
are displayed in the upper portion of the window. 
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12. Enable the Apply checkbox on those prepayment lines you want applied to the invoice. 

13. Enter the amount of the to be applied to this invoice in the Amount To Apply field. 

Example:  Below is a sample completed window. 
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14. Select the Apply/Unapply button. 

Result:  The applied prepayment is displayed in the Existing Prepayment Applications 
block. 
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15. Close the Apply/Unapply Prepayments window. 

Result:  You are returned to the Invoices window. 
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16. Select the Distributions button. 

Result:  The Distributions window is displayed. 
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17. Place your cursor in the first blank line. 

18. In the Amount field, enter the amount of the invoice. 

19. Tab to the Account field and enter the account value that was present on the original 
prepayment invoice. 

Note:  If you have copied the value from the original prepayment, you may utilize the past 
function to populate this field 

20. Select the  Edit Field button from the application toolbar. 

Result:  The Accounting Flexfield window is displayed. 
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21. Type 101002 into the SGL field and press the Tab key. 

Result:  The SGL field description is updated. 

 

22. Select the OK button. 
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Result:  The Accounting Flexfield window closes and the Distributions window is 
displayed. 

 

23. Tab to the USSGL field and enter NONE. 

24. Close the Distributions window. 

Result:  You are returned to the Invoices window. 
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If there are additional invoices to enter, goto task #25. Otherwise, goto task #26. 

25. Place your cursor in the next line. 

Goto task 6#. 

26. Close the Invoices window. 

Result:  You are returned to the Invoice Batches window. 
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27. Review the Batch Control Total and Actual Total fields to ensure that they match your 
control amounts. 

End of activity.  
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Clearing Outstanding Prepayments 
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Monthly Debit Memo Maintenance Process 
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Monthly Debit Memo Maintenance Process

After this lesson you should know how to:

• Describe the different types of debit memos

• Clear outstanding prepayments

Perform monthly maintenance of debit memos
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Option 3:  Oracle ExtensionMonthly Debit Memo Maintenance Process

Debit Memos are 
Deducted from
Future Payments

Debit Memos are 
automatically deducted 

from future travel 
payments to that payee

In order for a debit memo to be subtracted from a future payment, it 
must be released from hold and validated
On a regular basis, the OFM Travel Office should research debit 
memes on hold and release the holds that have not been refunded to 
the cashier

Travel Office Validates
Outstanding Debit 
Memos

1.  Locate Unpaid Debit 
Memos

2.  Release Hold

3.  Validate Debit Memos

 
In the event that the traveler does not refund the amount of the debit memo to the cashier, then 
the travel office will process the debit memos such that the amount can be automatically 
deducted from the traveler’s next payment. 
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Locating Debit Memos on Hold 
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Locating Debit Memos on Hold

Run the Invoices On Hold report to review 
debit memos on hold.

In the parameters window, select Debit Memo
in the Hold Name field

1.  Locate Unpaid 
Debit Memos
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Reviewing Debit Memos on Hold 
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Reviewing Debit Memos on Hold

Locate all invoices related to that travel 
document
In the Find Invoices window, place the root 
travel document number in the Invoice 
Number field followed by %

1.  Locate Unpaid 
Debit Memos

 
Before releasing the hold on the debit memo, confirm that the traveler legitimately owes the NIH 
the funds.  For example, ensure that the original prepayment was paid to the traveler.   
 
If you determine that the traveler never received the original payment for which the debit memo 
was created, cancel the original invoice and debit memo. 
 
If you determine that the traveler owes the NIH the funds and sufficient time has passed to 
refund the money to the Cashiers, then release the hold on the debit memo so that it can be 
deducted from future payments. 
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Releasing Holds on Unpaid Debit Memos 
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Releasing Holds on Unpaid Debit Memos

To release the hold on the debit memo,
Ensure your cursor is located in the line of 
the debit memo you want to release from 
hold
Press the Actions button
Enable the Release Holds checkbox
Select a Release Name from the LOV
and press the OK button

2.  Release Holds
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Validate Unpaid Debit Memos 
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Validate Unpaid Debit Memos

After releasing the holds, the debit memos must
be validated.

Press the Actions button
Enable the Validate checkbox and press the 
OK button

3.  Validate Debit 
Memos
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Invoices - Validating Invoices On Line 

Purpose 

The purpose of this document is to describe how to validate an invoice or group of invoices from 
the Invoices window. 

NIH Payables Cashier Office User 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the appropriate search criteria and select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Highlight invoices that you want to validate. 

3. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 
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4. Enable the Validate checkbox  

Example:  Below is a sample enabled validate checkbox. 
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5. Select OK. 

Result:  You are returned to the Invoices window. 
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Notes:   
− Refer to the Status and Holds fields to view the results of the validation program. 
− If the Status field displays "Needs Revalidation", view the holds that have been 

placed on the invoice. 

End of activity. 
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Validated Unpaid Debit Memos on the Preliminary Payment 
Register 
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Validated Unpaid Debit Memos on the 
Preliminary Payment Register

If no other invoice for the supplier is included in the batch, the debit 
memo will be indicated by **********.  The reason for non-payment will 
be that the invoice is below the minimum payment amount of $0.00

If another invoice for the supplier is included in the batch, the amount 
that will be paid to the traveler will be net of the debit memo
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Processing Debit Memos 
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Lesson Summary 
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Lesson Summary

In this lesson, you learned how to:

• Describe the different types of debit memos

• Clear outstanding prepayments for refunds 

• Perform monthly maintenance of debit memos
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GTA Reconciliation Support 
Activities 
Chapter 7 
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GTA Reconciliation Support Activities 

GTA Reconciliation Support Activities

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 

After this lesson, you will know how to:

• Record GTA Payments

• Process Payment to Impac Government Services
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Recording GTA Payments for Reconciliation 
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Recording GTA Payments for Reconciliation 

After this lesson, you will know how to:

Record GTA Payments for Reconciliation

• Process Payment to Impac Government Services
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Recording GTA Invoices 
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Recording GTA Invoices

GTA Invoices must be recorded in AP in order for them to be 
reconciled against the TMC Files.

AP
Invoice Workbench

Invoice#      Amount           Hold?

TR1025-CB $150          Yes
TR1026-CB $1125        Yes
TR1027-CB $857          Yes
TR1028-CB $125          Yes
TR1029-CB $736          Yes
TR1030-CB $356          Yes
TR1030-CB $125          Yes

Payment Workbench

Invoice#    Amount      Payment

Type
TR1025-CB $150  Recorded
TR1026-CB $1125Recorded
TR1027-CB $857  Recorded
TR1028-CB $125  Recorded
TR1029-CB $736  Recorded
TR1030-CB $356  Recorded
TR1031-CB $125  Recorded

NBS Travel System

 
This should be done on a daily basis. 
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Travel Invoices for Expenses Charged by TMC

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices imported 
f rom Open 
Interf ace

• Inv oices are 
place on hold

• Pay ments are 
recorded

G
TA

 H
O

LD
• Inv oices are 

Validated

• Inv oices are 
released 
f rom the hold

Cash 
Management

• Pay ments are 
reconciled

 
GTA Invoices that are interfaced from the NBS Travel System are on GTA hold.   
In order for them to be recorded, you must validate the invoices and release the GTA Hold.   
Once the hold is released and the invoices are validated, the payments can be recorded. 
 
 



 

GTA Reconciliation Support Activities   
 Chapter 7 - Page 7  

GTA Invoices 
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GTA Invoices

GTA Invoices that are interfaced from the NBS Travel System are:
1. Payable to Impac Government Services
2. Identified by an invoice number equal to the travel order number – CB
3. On hold – Awaiting Reconciliation

1

2

3
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Daily Process to Record GTA Invoices

NIH Payables User 
Records GTA 
Payment Batch

1.  Create, Build and 
Select Batch

2.  Review Batch

3.  Format Batch

4.  Confirm Batch

NIH Payables User 
Prepares GTA Invoices 
for Recording

1.  Locate USB 
Invoice Batch

2. Remove Holds

3.  Validate Invoices

 
This task should be done on a daily basis. 
 
When recording GTA payment batches, you must select Recorded document in the Payment 
Batches window.   
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Locating USB Invoice Batch 
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Locating USB Invoice Batch

Press the F11 key to enter query mode
Enter your search criteria

Invoice Batch Name = %USB%
Date = today’s date

Press the Ctrl + F11 keys

1.  Locate USB 
Invoice Batch
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Releasing the Hold on the GTA Invoices 

Page 8

Releasing the Hold on the GTA Invoices

To release the holds
Select the Invoices
button
From the menu bar, 
select Edit > Select All
Select the Actions 
button
Enable the Release 
Holds checkbox
Select a Release Hold 
Name and select the 
OK button

2.  Release Holds
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GTA - Releasing Holds From USB Invoices 

Purpose 

The purpose of this document is to describe how to release the holds from the Impac 
Government Services invoices interfaced from the NBS Travel System for recording through a 
payment batch.  This task must be completed prior to validating the invoices and recording 
payment. 

NIH Payables User 

N > Invoices > Entry > Invoice Batches  

Invoice Batches 

 

1. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

2. Enter your search criteria. 

Note:  We recommend entering TMUSB% in the Batch Name field and the current date in 
the Date field. 

3. Press the Ctrl + F11 keys to execute the query. 

Result:  The query results are displayed in the Invoice Batches window.  
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4. Place your cursor in the line of the invoice batch you want to release holds. 

5. Select the Invoices button. 

Result:  The Invoices window is displayed. 

 

Note:  The Supplier field should display Impac Government Services and the Invoice 
Numbers should be appended by CB or GTA.  If not, then you are in the wrong invoice 
batch. 
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6. From the menu bar, select Edit > Select All 

Result:  The invoices in the payment batch are selected and displayed in blue. 

Note:  If you receive a note that more than 100 records are found, select the Continue To 
End button. 

7. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 

 

8. Select the Release Holds checkbox. 

Result:  All is displayed in the Hold Name field. 

9. In the Release Name field, use the LOV to populate this field. 

Result:  The Release Reason defaults. 

Example:  Below is a sample completed Invoice Actions window. 
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10. Select the OK button. 

Result:  The Invoices window is displayed without the hold. 
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End of activity. 
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Validating Invoices 
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Validating Invoices 

If invoices require validation, you may run the validation program to 
ensure that all invoices are properly validated

1. Run the validation program with Impac Travel indicated in the 
Pay Group field

2. Review the log of the validation program to ensure that it 
completes with a status of “Normal”

3. If the program ends in an “Error” status
Review log to determine on which invoice the error was 
encountered
Correct funds checker errors
Re-run validation program

3. Validate Invoices
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Submitting the Invoice Validation Program 
NIH Payables User 

N > Other > Requests > Run 

Submit a New Request 

 

1. Select the OK button to submit a single request. 

Result:  The Submit Request window is displayed. 
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2. In the Name field, select Invoice Validation from the LOV. 

Result:  The Parameters window is displayed. 

 

3. Enter the report parameters as described below:  

 
Field Description 
Option Select All or New from the LOV.  All will validate all current 

invoices in the workbench.  New will validate only new 
invoices. 
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Invoice Batch Name Select the appropriate invoice batch name from the LOV. 
From Invoice Date Select the appropriate beginning invoice date from the LOV. 
To Invoice Date Select the appropriate ending invoice date from the LOV. 
Supplier Name Select the appropriate supplier from the LOV. 
Pay Group Select the appropriate pay group from the LOV. 
Invoice Number Select the appropriate invoice number from the LOV. 
Entered By Select the appropriate document creator from the LOV. 

Important:  In order to limit the invoices that are validated, you should at a minimum utilize 
either the Supplier Name or Pay Group field when running the validation program.   

4. Select the OK button. 

Result:  The Parameters window closes. 

5. Select the Submit button to submit Invoice Validation Program.  

Result:  The Request window is displayed. 

 

6. Select the Refresh Data button until the process indicates a Phase of "Completed". 

If the program ends with a status of Error, goto task #7. Otherwise, end of activity. 

7. Select the View Log button to determine the reason for the error. 

Result:  The View Log window is displayed. 
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End of activity. 
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Validating Invoices 
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Validating Invoices 

If the validation program ends in an Error status, 
select the View Log button to determine on which 
invoice the error occurred.

3. Validate Invoices

 
If the validation program ended in error due to a Funds Checker error, correct the error and run 
the validation program again. 
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Confirming Invoice Validation of GTA Invoices 
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Confirming Invoice Validation of GTA Invoices

To ensure that all invoices were validated, use 
the Find Invoices window to locate unvalidated 
invoices or invoices that need revalidation

3. Validate Invoices

1. Enter Search 
Parameters

• Supplier Name = 
Impac Government 
Services

• Dates = Current 
month

• Status = Never 
Validated and 
Needs Revalidation

2. Press the Find 
button
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Recording GTA Standard Invoices 
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Recording GTA Standard Invoices

When creating the payment batch select the 
following:

Payment Batch Name = TRPYDDDUSB
Document = USB.Recorded
Supplier Name = Impac Government Services

IMPORTANT!
If you do not select the correct document type 

of Recorded, payments will be sent to 
Treasury.  Treasury may process the 

payments, resulting in duplicate payments to 
Impac.

NIH Payables User 
Records GTA 
Payment Batch

1.  Create, Build and 
Select Batch

2.  Review Batch

3.  Format Batch

4.  Confirm Batch

 
By selecting the document type of “Recorded”, the payments will not go to Treasury for actual 
payment to Impac Government Services.  Instead, the payments will simply be recorded as paid 
in AP so that we can reconcile the TMC invoice to these payments. 
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Payments - Create, Select, and Build a Payment Batch for Travel 

Purpose 

The purpose of this document is to describe how to create, select and build payment batches in 
NBS.   

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Click into Transaction Event field and select the appropriate transaction code from the 
LOV. 

Result:  The Transaction code field value defaults.   

2. Select the OK button. 

Result:  The Payment Batches window is displayed.  Use the folder tools to select the NBS 
folder. 
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3. Create the batch by completing the following fields: 

 
Field Description 
Batch Name Enter a batch name. 

Notes: 
This value must be unique.   
Refer to the Payment Batch Naming Convention job aid. 

Payment Date Defaults to the current date. 
Status Defaults to New.  This field cannot be updated 
Next Step Defaults.  This field cannot be updated. 
Pay Group Select the appropriate value from the LOV. 
Invoice Batch Name Select an invoice batch name from the LOV. 

Note:  Only payments for invoices in this batch will be 
selected. 

Bank Account Defaults select Main Disbursement. Do not change 
Document Select a value from the LOV, depending upon the method 

of payment. 
 
Note:  The system will display messages related to the 
reservation of document numbers.  Select the OK button to 
both messages. 

Payment Method Defaults based upon document. 
Pay Through Date Defaults to five days from the current date.   
Supplier Name Select a supplier name from the LOV. 

Note:  Only payments for this supplier will be selected. 
First Document Number Defaults to the next available check or wire transfer 

number. 
Last Document Number Defaults.  Do not change. 
Document Order Defaults to Supplier Name 

Example:  Below is a sample completed Payments window. 
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4. Select the Actions... button. 

Note:  The Payment Batches Action window is displayed. 

 

5. Confirm that the Select Invoices and Build Payments check boxes are enabled. 
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6. Enable the Print Preliminary Register checkbox. 

7. Tab to the Printer field and select a printer from the LOV. 

Note:  If you do not want the report to print automatically, select no print.  The report will 
still be accessible through the Requests window. 

Example:  Below is a sample completed Payment Batches Action window. 

 

8. Select the OK button. 

Result:  The concurrent request is submitted and a message box is displayed with the request 
ID number. 

 

9. Select the OK button. 
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Result:  You are returned to the Payment Batches window. 

 

10. Select the Requery Batch button and review the batch status and next step.  Repeat until the 
status changes to Built. 

Example:   

 

If the Status field indicates an error, goto task #11.   

If you want to review an on-line version of the report, goto task #12.  Otherwise, end of 
activity. 

11. Contact the NIH Help Desk. 

End of activity. 

12. From the menu bar, select View > Requests to review the status of your request. 

Result:  The Find Requests window is displayed 
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13. Select the Find button. 

Result:  The Requests window is displayed. 

 

14. Select the Refresh Data button to check on the status of the requests until the request lines 
complete with a status of normal. 

15. Highlight the Preliminary Register Report. 
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16. Select the View Output button. 

Result:  The Report - Request ID... window is displayed. 

 

17. Select Tools > Copy File from the menu bar. 

Result:  The Preliminary Register Report will be displayed in a browser window. 
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End of activity. 
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Payments - Formatting a Payment Batch 

Purpose 

Formatting a payment batch creates the payment batch file and places that file on the server for 
the US Treasury to pick up for processing.  Once a payment batch is formatted, it cannot be 
modified.  If changes are required to a formatted payment, it must be cancelled and CIT and 
Treasury contacted immediately. 

Prior Activity 

Before completing this activity, the payment batch must have been created and built.  Refer to 
Create, Build and Select a Payment Batch [NAV1009A]  

Note:  If the payment batch window displays the batch you want to format, then skip Steps #1-7. 

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 

Result:  A caution window is displayed.   

2. Select the OK button. 

Result:  The Payment Batches window is displayed. 



 

GTA Reconciliation Support Activities   
 Chapter 7 - Page 35  

 

3. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

4. Enter the search criteria to locate the batch, such as the batch name. 

5. Press the Ctrl + F11 keys  

Result:   The batches meeting the search criteria are displayed. 

 

7. Highlight the batch(s) to be formatted. 

Note:  The Status of the batch must be "Built".  Also, the number of payments in the batch 
must be one or greater. 

8. Select the Actions... button. 

Result:  The Payment Batches Action window is displayed. 
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9. Confirm that the Format Payments check box is enabled. 

10. Select the OK button. 

Result:  A message box is displayed that asks if you want to perform AP/AR Netting. 

 

11. Select No. 

Result:  The concurrent request is submitted and a message box is displayed with the request 
ID number. 

12. Select the Requery Batch button to review the batch status and next step. 
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13. Review the Next Step field to ensure that there were no errors during formatting. 

If there were formatting errors, goto task# 14.  Otherwise, end of activity. 

14. Contact the NIH Help Desk. 

End of activity. 
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Payments - Confirming a Payment Batch 

Purpose 

The purpose of this document is to describe how to confirm a payment batch in Accounts 
Payable.  Confirming is the final step in processing a payment batch. This step updates the 
payment history of invoices paid in a payment batch, associates payment document numbers 
with the invoices and invoice payments, and releases the payment document for use on future 
batches. Also, the accounts payable period cannot be closed until all payment batches in progress 
are completed. 

Prior Activity 

Before completing this activity, the payment batch must have a status of Formatted, and the 
Next Step field must display Confirm.  

In addition, for check payment batches you will be required to enter the payment document 
range.  Before starting the confirmation process, write down the starting payment document 
number and number of negotiable payments in the batch. 

Note:  If the Payment Batch screen has not been closed after formatting the payment batch, the 
user may skip steps 1 - 7.  

NIH Payables User 

N > Payments > Entry > Payment Batches 

Enter Transaction Events 

 

1. Close the Enter Transaction Events window 

Result:  An error message is displayed.   

2. Select the OK button. 
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Result:  The Payment Batches window is displayed. 

 

3. Press the F11 key to enter query mode. 

Result:  The fields turn blue. 

4. Enter the search criteria to locate the batch, such as the batch name. 

5. Press the Ctrl + F11 keys  

Result:   The batches meeting the search criteria are displayed. 

 

7. Highlight the batch(es) to be confirmed by placing your cursor in the lines of the batch. 

8. Select the Actions...1 button. 

Result:  The Payment Batches Action window is displayed. 
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9. Confirm that the Confirm Payment Batch and the Print Final Register checkboxes are 
enabled. 

10. Tab to the Printer field and select the appropriate printer from the LOV. 

Example:  Below is an example of a completed Payment Batch Actions window. 
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12. Select the OK button. 

If you are confirming a check payment batch, goto task #13. Otherwise, goto task #15. 

13. In the Status field, select Printed from the LOV. 

14. In the To field, enter the final check number. 

Hint:  To calculate the final check number, add the beginning check number to the number 
of negotiated payments in the batch and subtract 1. 

Goto task #16. 

15. Review the information displayed. 

Example:  The Confirm Payment Batch window is displayed. 
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16. Select the Confirm button. 

Result:  A message box is displayed that provides the request ID. 

17. Select the OK button. 

18. Select the Requery Batch button to confirm that the Status is Confirmed. 

Result:  The Status field displays Confirmed.  

 

End of activity. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 1:  Recording GTA Invoices 
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Process Payments to Impac Government Services 
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Process Payments to Impac Government 
Services

After this lesson, you will know how to:

• Record GTA Payments

Process Payment to Impac Government Services 
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Payment to Impac Government Services 
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Payment to Impac Government Services

Travel Management Center
Impac Government Services

(US Bank)

OFM Travel Office

Invoice with
flat file

Payment based 
on updated 
TMC invoice

Payment

Updated i nvoice 
with flat file

1

2

3

 
1.  U.S. Bank sends an invoice, including a file that includes all GTA transactions for the month, 
per account to OFM and the appropriate TMC 
2.  The TMC’s 

 - review the file for errors 
 - contact US Bank if necessary 
 - make updates to the file (include credits for cancelled trips, updates on ticket costs if 
erroneous) 
 - send a copy of modified file to OFM Travel Office 
 - send hard copies of backup documents to the OFM Travel Office  

3.  The OFM Travel Office  
 -  reviews the files from U.S. Bank and the TMCs 
 -  processes payment to U.S. Bank based upon the total amount due noted on the TMC’s 
records for each account 
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Note:   
Transactions tied to record of calls will be paid from the legacy system.  This split in payment 
and reconciliation will continue until the deployment of Track 4.  
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Processing Payments to Impac Government Services 
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Processing Payments to Impac Government 
Services

The payments to Impac Government 
Services will be processed through the 
ECS system directly
No action should be taken within the 
NBSImpac Government Services

(US Bank)

OFM Travel Office

Payment based 
on updated 
TMC invoice
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Lesson Summary 
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Lesson Summary

In this lesson you learned how to:

• Record GTA Payments

• Process Payment to Impac Government Services
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Invoice and Payment 
Processing Error Resolution 
Chapter 8 
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Invoice and Payment Processing Error Resolution 

Invoice and Payment Processing Error 
Resolution

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 
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Lesson Objectives 

After this lesson you should know how to:

• Troubleshoot invoice processing errors

• Troubleshoot payment processing errors
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Why isn’t an invoice being paid? 

Page 2

Why isn’t an invoice being paid?

Questions to ask:
1. Is the invoice in AP?
2. Is the invoice free of holds?
3. Is the invoice validated?
4. Is the invoice due based upon the invoice/terms date and payment

terms?
5. Does the invoice have the correct Pay Group?
6. Does the invoice contain the necessary SSN, Address (Check), and

Banking (Electronic)?

 
When researching the cause of non-payment of an invoice, ask the questions above to determine 
if there is a problem with the invoice. 
 
Notes:   
If the answer to the question is yes, proceed to the next question.   
If the answer to the question is no, review the information in this chapter to help resolve the 
issue. 
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The Invoice is Not In Accounts Payable 
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The Invoice is Not In Accounts Payable

Travel document was not approved 
in NBS Travel System

Ask travel planner to review 
document status in the NBS Travel 
System

Invoice encountered an error during 
import into AP

Check the daily import error log to 
determine if invoice failed to import.

AP Open 
Interface

AP
Invoice 

Workbench

NBS Travel 
System

The following are the most common reasons that an invoice is not in 
Accounts Payable.

 
The NMC emails the import error log on a daily basis to the OFM Travel Office.  The report lists 
the invoices and the errors encountered. 
The NMC is responsible for resolving the errors. 
 
The Travel Office is responsible for reviewing the report and being aware of any invoices stuck 
in the open interface table that may affect their other activities (Example:  GTA Reconciliation) 
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The Invoice Is on Hold 

Page 4

The Invoice Is on Hold

Should the hold be removed?
Certain holds should only be removed by certain groups. For 
example, the cashiers should be the only group that release the 
Cashier Payment and Recorded Patient Pay Holds
Ensure the reason for the hold has been resolved.  For example, if an 
invoice is on Invoice Research hold, ensure the necessary steps have 
been taken to correct the invoice prior to releasing the hold.

If an invoice is on hold, it is not eligible for payment
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The Invoice Is on Hold 
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The Invoice Is on Hold

If manually entered, then correct inv oice distribution to match 
inv oice amount.
If imported from travel, then contact the NIH Help Desk.

Dist Variance

Research and contact trav eler , rev iew Supplier record, release hold 
when SSN is av ailable

No Tax ID

Research and contact trav eler, update inv oice as necessary, and 
release hold

Void Payment

Release as part of the debit memo monthly  processDebit Memo

NoneRecorded Patient Payments

Research and contact trav eler, update inv oice, and release hold*Bank Research

Research and contact trav eler, update inv oice, and release hold*Address Research

Contact the NIH Help DeskAll Others

Release the other hold f irst and then v alidate the inv oiceCan’t Try PO Close

Release the hold through the Holds buttonQty Ordered

Release as part of daily  GTA support activitiesReconciliation Process

Research and contact trav eler, update inv oice, and release hold*Invoice Research

NoneCashier Payment

Action Needed by NIH Travel Payables UserHold Name

 
*  Refer to information located within this chapter on missing bank, SSN, and Address 
Information. 
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Invoices - Releasing Holds from Invoices 

Purpose 

The purpose of this document is to describe how to release holds from invoices.  Only certain 
types of holds can be released according to this procedure, including the following: 

− Cashier Payment 
− Debit Memo 
− Invoice Research 
− Patient Recorded Pay 
− Reconciliation Process 
− Void Payment 

Other holds may be released by validating the invoice.  Refer to Validating Invoices On-Line 
[NAV1003A]. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter search criteria into the Find Invoices window 
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2. Select the Find button. 

Result:  The invoices matching your search criteria are displayed. 

 

3. Highlight the invoice that you would like to release from hold. 

4. Select the Holds button. 

Result:  The Holds window is displayed. 
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Note:  If the hold can only be released through Validation, the Release Name and Release 
Reason fields will be grey. 

5. In the Release Name field, use the LOV to select an appropriate value. 

Result:  The Release Reason defaults. 

6. Save the record. 

Result:  The Release Date and Released By fields are populated. 
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7. Close the Holds window 

Result:  The hold on the invoice should be released. 

 

End of activity. 
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Invoice Is Not Validated 
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Invoice Is Not Validated

If the invoice is not validated, it cannot be paid.

To validate the invoice:
Locate the invoice
Select the Actions button
Enable the Validate checkbox
Select the OK button.

Possible results:
1. The invoice status is “Validated” or “Unpaid” for prepayments
2. The invoice has been placed on hold and the status indicates that it “Needs 

Revalidation”
3. The invoice status remains unchanged.

• The Funds Check Error that may be encountered when invoices are validated does 
not result in an invoice hold, but rather halts the validation program so that the 
process does not complete.

 
Refer to the job aid for instructions on how to correct the Funds Check Error. 
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Invoices - Validating Invoices On Line 

Purpose 

The purpose of this document is to describe how to validate an invoice or group of invoices from 
the Invoices window. 

NIH Payables Cashier Office User 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the appropriate search criteria and select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Highlight invoices that you want to validate. 

3. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 
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4. Enable the Validate checkbox  

Example:  Below is a sample enabled validate checkbox. 
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5. Select OK. 

Result:  You are returned to the Invoices window. 
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Notes:   
− Refer to the Status and Holds fields to view the results of the validation program. 
− If the Status field displays "Needs Revalidation", view the holds that have been 

placed on the invoice. 

End of activity. 
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Reviewing the Invoice Date and Terms 
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Reviewing the Invoice Date and Terms

The payment process selects invoices for payment based upon the 
payment terms and the terms date.

If the payment terms are Immediate, the invoice will be eligible for 
payment as of the terms date.
If the payment terms are Prompt Pay, the invoice will be eligible for 
payment 30 days after the terms date.

 
Notes:   
• Travel advances are imported with an invoice date and terms date of 10 days prior to the 

start of the trip. 
• When creating payment batches, the select process will include all invoices that are eligible 

for payment up to five days after the current date. 
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Reviewing the Pay Group 
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Reviewing the Pay Group

Does the invoice reference the correct Pay Group?

When creating a payment batch for Treasury, you will identify a Pay 
Group.  If an invoice is not being selected for payment, ensure that the 
invoice references the correct Pay Group.
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Required Payment Information is Missing 
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Required Payment Information is Missing

The following information is required for payment:
Supplier Bank Information and SSN for Treasury Electronic Batches
Supplier Address information and SSN for Treasury Check Batches

+

+

Electronic 
Payment

Check     
Payment
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Missing SSN, Bank, or Address Information 
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Missing SSN, Bank, or Address Information

Determine if necessary payment information is missing by running the:
NIHAP Unpaid Invoices Detail Report
NIHAP Unpaid Invoices Error Resolution Report for Payment Batch

Refer to Chapter “Accounts Payable Reports” on how to run and interpret 
the reports.

Important:  If these reports are not run prior to running the payment 
batch, the payment batches may end in an error status or Treasury may 
reject the batch.

 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Invoice and Payment Processing Error Resolution   
 Chapter 8 - Page 22  

Missing Bank (ACH) Information 
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Missing Bank (ACH) Information

Supplier bank information is required for all electronic payments
Invoices needing bank information should be on a Bank Research 
Hold
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Missing Bank (ACH) Information 
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Missing Bank (ACH) Information

There are two ways to resolve the problem:  
After Government Accounting enters the bank information, update the 
invoice to reflect the bank account
Change the invoice payment method to check, if address information is 
available.
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Option 1:  Enter Bank Information and Update Invoice 
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Option 1:  Enter Bank Information and Update 
Invoice

Resolution Option 1:  
Enter Bank Information in Supplier Table and Update Invoice

Contact the traveler to request that they submit their ACH information
Run the NIHAP Unpaid Invoices Detail Report
For those invoices that indicate “ACH Exists for Vendor”, update the 
invoice with the banking information and release the hold.
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Updating the Bank Information on the Invoice 
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Updating the Bank Information on the Invoice

The Supplier bank account information can be updated by selecting 
the Scheduled Payments button on the Invoices window.

 
Refer to instructions on Updating Bank Information on an Invoice. 
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Releasing the Invoice Hold 
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Releasing the Invoice Hold

Once the problem causing the return has been resolved, the invoice 
must be released from hold in order to be processed.

 
Once an invoice has been released from hold and validated, it may be selected for the next 
payment batch. 
Refer to instructions on Releasing Holds on Invoices 
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Option 2:  Changing Payment Method 
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Option 2:  Changing Payment Method

Resolution Option 2:  
Change Payment Method

Based on the OFM 
guidelines, you may 
update the payment 
method on the invoice.  
When applicable, payment 
method can be changed to 
“Check” and a check 
treasury payment batch be 
created.
Refer to the NIHAP 
Unpaid Invoices Detail 
Report for electronic 
payments that contain 
address and SSN 
information
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Changing the Payment Method on Single Invoices 
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Changing the Payment Method on Single 
Invoices

If the need arises, you may select a different payment method for all 
unvalidated invoices.
Once an invoice has been validated, the system may not allow 
changes to the Payment Method, depending upon the invoice type.
You should follow existing NIH Policy on issuing check payments from 
Treasury.

 
Refer to instructions on Updating the Invoice Payment Method 
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Missing Address Information 
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Missing Address Information

The NIHAP Unpaid Invoice Detail and NIHAP Unpaid Invoices Error 
Resolution Payment Batch Reports will alert users to missing 

address information.
The traveler should update the address information in NED or 
Employee Express.

Missing address information will prevent check payments from being 
processed
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Updating the Address Information on the Invoice 
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Updating the Address Information on the 
Invoice

The Supplier address information can be updated by selecting the 
LOV on the Supplier Site field.

 
Note:  For travel, the value in the Site field may not change depending upon how the updates 
were made to the address by Government Accounting.  However, you will be able to validate the 
supplier’s address within the Supplier table and on the Preliminary Payment Register Report. 
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Missing SSN 
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Missing SSN

Supplier SSN is required on all electronic and check payments.

The NIHAP Unpaid Invoice Detail and NIHAP Unpaid Invoices Error 
Resolution Payment Batch Reports will alert users to missing 

SSN information.
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Reviewing Supplier Records for SSN 
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Reviewing Supplier Records for SSN

You may view the supplier SSN record by selecting the Overview
button 

Taxpayer ID is 
visible on the 

Invoice Overview 
window

 
Action needed to process remaining payments in the batch: 

• Determine which supplier is missing SSN 
• Void all the payments in the batch 
• Place the invoices for the supplier missing SSN on “SSN Research” hold 
• Create a new check payment batch 
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Missing SSN 
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Missing SSN

If the SSN exists in HR, but not in the Vendor, contact the 
Government Accounting office to update the Vendor record.
If the SSN does not exist in HR or Vendor, contact the traveler to 
request that an SSN number be entered into NED
Once the SSN number appears on the supplier record, the hold may
be released on the invoice.
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Practice Lab

Lab Time

 
Complete Lab:  Troubleshooting Invoice and Payment Processing Errors 
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Lesson Summary

In this lesson, you learned how to:

• Troubleshoot invoice processing errors

• Troubleshoot payment processing errors

 



 

 Copyright © Oracle Corporation, 2001. All rights reserved.  

Invoice and Payment Processing Error Resolution   
 Chapter 8 - Page 36  
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Accounts Payable Reports 
Chapter 9 
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Accounts Payable Reports 

Accounts Payable Reports

Track 2 End User Training
Revised June 1, 2004
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Lesson Objectives 

After this lesson, you will know how to run:

• the Invoices on Hold Report

• the NIHAP Unpaid Invoices Detail Report

• the NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch

• the Unaccounted Transaction Report

• the Invoice Aging Report

• the NIH Unpaid Invoices Supervisor Summary Report
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Running Reports 
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Running Reports

All Accounts Payable Reports are run in the same manner.
The navigation path to run reports in Accounts Payable is
N > Other > Requests > Run
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Submitting a Single Request 

Purpose 

The purpose of this document is to describe how to submit a single request in the NBS Financial 
Modules.  The steps will be the same regardless of the report or program that is being submitted.  
However, the request name and parameters will vary depending upon the module.  In addition, 
the navigation path may be different.  The student guide will describe the exact navigation path 
for each responsibility. 

NBS Financial Modules 

N > Requests > Run 

Submit a New Request 

 

1. Select the OK button. 

Result:  The Submit Request window is displayed. 
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2. Click on the LOV in the Name field and select the report or program you want to run. 

Result:  The Parameters window is displayed.  NOTE:  This window will be different for 
each report that you select. 

 

3. Complete the Parameters window and select the OK button. 

Result:  You are returned to the Submit Requests window. 
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If you want to run the report now for a single time, goto task #10. Otherwise, goto task #4. 

4. Select the Schedule button in the At these times block. 

Result:  The Schedule window is displayed. 
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5. Select the appropriate schedule alterative in the Run the Job... block. 

If you want to run the job once, goto task #6.  

If you want to run the job periodically, goto task #7 Otherwise, goto task #8. 

6. In the Run At field, enter the date and time you want the job to run.  The time should be 
entered in military time (24 hour clock) 

Example: 
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Goto task #9. 

7. Complete the schedule information. 

Example: 



 

Accounts Payable Reports   
 Chapter 9 - Page 10  

 

Goto task #9. 

8. Complete the schedule information. 

Example:   
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9. Select the OK button. 

10. Determine whether or not you want to view the report prior to printing. 

If you want to print the report before viewing it on-line, goto task #11. Otherwise, goto task 
#14. 

11. Select the Options button. 

Result:  The Upon Completion window is displayed. 
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12. Select a printer and the number of copies 

13. Select the OK button. 

14. Select the Submit button. 

Result:  The result will depend upon the report and the schedule that you have selected.  To 
view the output of the request on line, select View > Requests from the menu bar.  This will 
take you to the Requests window. 

End of activity. 
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Daily Reports

On a daily basis, the following reports should be run to ensure that 
invoice problems are resolved so that they can be paid in a timely 
manner.

Invoices On-Hold Report
NIHAP Unpaid Invoices Detail Report
NIHAP Unpaid Invoices Detail Report for Payment Batch
Unaccounted Transactions Report
NIHAP Supervisors Summary Unpaid Invoices Report

 
The NIHAP Unpaid Invoices Detail Report and Invoices On-Hold Report should be run and 
issues resolved prior to creating the daily treasury payment batches.   
 
The NIHAP Unpaid Invoices Detail Report for Payment Batch is run for each payment batch 
processed to Treasury. 
 
The Unaccounted Transactions Report can be run at any point throughout the day. 
 
The NIHAP Supervisors Summary Unpaid Invoices Report should be run daily to keep abreast 
of outstanding payments.  The supervisor may review the NIHAP Detail Report if 
troubleshooting. 
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Invoices On-Hold Report 

Description: The invoice on-hold report displays the AP invoices 
that are currently on-hold

Purpose: This report can be used to monitor invoices that are 
currently on-hold to ensure that any necessary 
actions needed to resolve the hold are being taken

The report provides you the total number and 
amount of invoices on hold

Source: Accounts Payable

Frequency: Daily

 
Selected Report Headings 
 
PO Number. If the hold on the invoice is related to the purchase order match, then Payables 
displays the purchase order number. 
Functional Currency Original Amount. Invoice amount expressed in your functional currency.  
Functional Currency Amount Remaining. Remaining amount due for payment on an invoice, 
expressed in your functional currency. The amount remaining is equal to the original amount, 
unless you partially paid an invoice.  
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Invoices On-Hold Report

Sample report parameters:

 
Selected Report Parameters 
 
Hold Name. If you want to review only invoices with a specific hold applied, enter the name. 
Leave this parameter blank if you want the report to include the Invoices with Scheduled 
Payment Holds section and the Invoices with Supplier Site Set to Hold All Payments section. 
Order By. This parameter controls the sorting for the first report section. You can choose to sort 
and subtotal by hold or supplier. 
On Hold by Period Option. Enter Yes to subtotal the invoices by the period of their invoice 
date. 
From/To Entered Date. Displays invoices with holds that were applied on and between the 
From Entered Date and the To Entered Date.  
Include Due or Discount Date. The report includes invoices that have a due or discount date 
within a range you specify, using the From/To Due or Discount Date parameters.  

•Due. Displays only invoices that have a due date within the range you specify. 
•Discount. Displays only invoices that have a discount date within the range you specify. 

Include Hold Descriptions. Change this parameter to No if you do not want to include the last 
section of the report as a reference of hold descriptions. 
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Invoices On-Hold Report

Invoice holds must be resolved for the invoice to be eligible for payment.

Refer to Chapter “Troubleshooting Invoice and Payment Processing Errors”
in this Student Guide for guidance on resolving invoice holds
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NIHAP Unpaid Invoices Detail Report 

Description: The custom report displays invoices that are missing 
banking, SSN, or address information that will 
prevent payment

Purpose: This report should be used to identify invoices that 
are missing required information and to determine 
how to correct the issue.

Source: Accounts Payable

Frequency: Daily

 
Selected Report Headings 
Invoice Number:  Invoice number 
Invoice Date:  Date of the invoice 
Invoice Amount:  Original amount of the invoice 
Employee Number:  Employee number  
Vendor Name:  Name of payee of the invoice 
Address Information:  Address information for the vendor.  If no address exists, it will be noted 
on the report 
Vendor Type:  Type of vendor, such as Fellow, Employee, Contractor, Guest Speaker, etc. 
Payment Method:  Check or EFT 
ACH Existence:  Indicates if ACH exists. 

No ACH Data – indicates that no ACH data exists for this vendor.  Contact the traveler 
or preparer for resolution. 
ACH only in Staging Table – indicates that ACH data exists for the vendor, but it has 
not successfully made it from the staging table into NBS.  Contact the NIH Help Desk to 
resolve. 
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ACH data exists for Vendor – indicates that ACH data exists for the vendor, but has not 
been included in the invoice.  Update the invoice banking information to resolve 

SSN:  Vendor – Yes, indicates that SSN number exists.  No, indicates that no SSN number 
exists on the supplier record.  In order to process a payment, the SSN number must be on the 
vendor record. 
SSN:  HR – Yes, indicates that SSN number exists on the employee record.  No, indicates that 
no SSN number exists on the employee record.   
If SSN information is missing from both the Vendor and HR records, contact the traveler or 
travel planner. 
If the SSN information exists in HR, but is missing from the Vendor record, contact Government 
Accounting to update. 
Preparer – The name of the individual who prepared the travel document 
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NIHAP Unpaid Invoices Detail Report 
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NIHAP Unpaid Invoices Detail Report

Sample report parameters:

 
Report Parameters 
IC:  Select an IC or leave blank for all ICs 
Include Missing SSN:  Select Yes, if you want to view invoices with missing SSN information. 
Include Missing ACH:  Select Yes, if you want to view invoices with missing ACH 
information. 
Include Missing Address: Select Yes, if you want to view invoices with missing address 
information. 
Include Missing ACH, with Address and SSN:  Select Yes, if you want to view invoices 
without ACH, but with Address and SSN.  These invoices would not be eligible for electronic 
payment, but are eligible to be paid by check. 
Include ACH in Vendor not Invoice:  Select Yes, if you want to review invoices for which 
ACH exists for the Vendor, but it is not on the invoice.  These invoices would be eligible for 
payment, if the ACH information is updated on the invoice. 
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NIHAP Unpaid Invoices Detail Report

The following indicate ACH errors

2

3

1

 
1. No ACH data exists for the vendor 

Action Required: 
Place invoice on Bank Research hold 
Contact the traveler or travel planner and request that they update their banking 

information 
Options:  Have the individual provide ACH information to OFM following existing 

guidelines or update the payment method to check since address and SSN 
information is available.  See chapter on Troubleshooting Invoice and Payment 
Processing Errors for more details. 

 
2.  ACH exists in staging table, but has not successfully made it to the NBS 

Action Required:   
Place invoice on Bank Research Hold 
Contact the NIH Help Desk and report the error 

 
3.  ACH exists for Vendor, but the invoice does not contain that information 
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Action Required: 
Update invoice banking information on the invoice 
Remove invoice from hold if necessary 
Refer to the chapter “Processing Treasury Payment Batches” for information on how to 

update banking information on invoices and release holds. 
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NIHAP Unpaid Invoices Detail Report

The following indicate SSN errors

2

1

3

 
1. SSN does not exist in HR or Vendor for EFT payment 

Action Required: 
Place invoice on SSN Research hold 
Contact Traveler or Travel Planner to update their SSN in NED or Employee Express 

 
2. SSN does not exist in HR or Vendor for Check payment 

Action Required: 
Place invoice on SSN Research hold 
Contact Traveler or Travel Planner to update their SSN in NED or Employee Express 

 
3.  SSN Exists in HR, but not in Vendor 
Action Required: 

Place invoice on SSN Research hold 
Contact Government Accounting to update vendor SSN information 
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NIHAP Unpaid Invoices Detail Report 
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NIHAP Unpaid Invoices Detail Report

The following indicate address errors

 
Address information does not exist for the traveler. 
Since this is a check payment, address information must exist to process the payment. 
Action Required 
Place invoice on Address Research hold. 
Contact the traveler or travel planner to have the individual update their address in NED or 

Employee Express 



 

Accounts Payable Reports   
 Chapter 9 - Page 24  

Unaccounted Transactions Report 

Page 12

Unaccounted Transactions Report 

Description: The unaccounted transactions report displays the AP 
invoices and payments for which the accounting has 
not been properly created. 

Purpose: Use this report to identify and review all unaccounted 
invoice and payment transactions and see the 
reason that Payables cannot account for a 
transaction. 

Source: Accounts Payable

Frequency: This report should be daily and should specifically 
be run as part of the monthly close process

 
Important:   
If transactions appear on this report, then the accounting information for the transaction 
will not be transferred to the General Ledger or the Data Warehouse 
 
Selected Report Headings 
The report has two sections: Unaccounted Invoices, and Unaccounted Payments. All amounts are 
in the transaction currency. 
Unaccounted Invoices 
This section of the report lists the supplier name, supplier number, invoice number, invoice date, 
invoice currency, invoice amount, purchase order number (if the invoice is on a purchase order 
matching related hold), and the exception. 
Unaccounted Payments 
This section of the report lists the supplier name, supplier number, payment number, payment 
date, payment currency, payment amount, and exception. 
Exception. The report displays one or more of the following exception conditions:  

•   Dist Acct Invalid. The account on the invoice distribution is invalid. 
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•   Dist Variance. The sum of the invoice distributions is not equal to the invoice 
amount.  
•   Funds Check. Funds check failed for this invoice.  
•   Unaccounted. The Payables Accounting Process has not been submitted for the 
transaction. 
•   Other Hold Names. This invoice has a hold applied to it that prevents accounting.  
•   Unvalidated. You have not submitted Invoice Validation for the invoice. 
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Unaccounted Transactions Report 

Sample report parameters:

 
Selected Report Parameters 
Note: If you do not specify a value for the Period Name or From/To Accounting Date 
parameters, then the report lists all unaccounted entries, regardless of date. 
 
From/To Accounting Date. If you want to run the report for a particular date range, then enter 
both the first and last dates in the range. If you enter values for a date range, then you cannot 
enter a value for Period Name. (Recommend using the first and last date of the current month) 
 
Period Name. If you want to run the report for a single period, enter the period name. If you 
enter a value here, you cannot enter values in the From/To Accounting Date parameters. 
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Reviewing the Unaccounted Transaction 
Report

Will be resolved when create accounting program runs nightly OR
If  closing is required, create accounting for the invoice manually.

Unaccounted 
Invoice

1. Validate Invoice
2. Create Accounting for Invoice

Not Validated

If invoice was manually entered, then correct invoice distribution
If invoice was imported from Travel, then contact the NMC

Dist Variance
Steps to ResolveException
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Invoices - Validating Invoices On Line 

Purpose 

The purpose of this document is to describe how to validate an invoice or group of invoices from 
the Invoices window. 

NIH Payables Cashier Office User 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the appropriate search criteria and select the Find button. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Highlight invoices that you want to validate. 

3. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 
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4. Enable the Validate checkbox  

Example:  Below is a sample enabled validate checkbox. 
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5. Select OK. 

Result:  You are returned to the Invoices window. 
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Notes:   
− Refer to the Status and Holds fields to view the results of the validation program. 
− If the Status field displays "Needs Revalidation", view the holds that have been 

placed on the invoice. 

End of activity. 
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Invoices - Creating Accounting for Invoices On Line 

Purpose 

The purpose of this document is to describe how to create accounting for an invoice or group of 
invoices from the Invoices window. 

Important:  Before accounting can be created for an invoice, the invoice must be validated.  
Refer to Validating an Invoice On Line [NAV10070A] 

 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. Enter the appropriate search criteria and select the Find button. 

Note:  You may use the Invoice Status - Accounted field to search for unaccounted 
invoices.  However, other search criteria, such as Type, Pay Group, or Dates, must be used 
in conjunction with the Accounted criteria. 

Result:  The invoices matching your search criteria are displayed in the Invoices window. 
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2. Highlight invoice(s) for which you want to create accounting. 

Note:   You may highlight all invoices by selecting Edit > Select All from the menu bar. 

3. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 
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4. Enable the Create Accounting checkbox  

Example:  Below is a sample enabled Create Accounting checkbox. 
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5. Select OK. 

Result:  You are returned to the Invoices window and the Accounted field will display Yes. 
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End of activity. 
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Batch 

Page 15

NIHAP Unpaid Invoices Error Resolution 
Report for Payment Batch

Description: The custom report displays invoices that are missing 
banking, SSN, or address information that will 
prevent payment for a particular payment batch

Purpose: This report should be used to identify invoices that 
are missing required information for payment so that 
they can be removed from the payment batch prior 
to formatting

Source: Accounts Payable

Frequency: Run after Building and Selecting the payment batch

 
Selected Report Headings 
Invoice Number:  Invoice number 
Invoice Date:  Date of the invoice 
Invoice Amount:  Original amount of the invoice 
Employee Number:  Employee number  
Vendor Name:  Name of payee of the invoice 
Address Information:  Address information for the vendor.  If no address exists, it will be noted 
on the report 
Vendor Type:  Type of vendor, such as Fellow, Employee, Contractor, Guest Speaker, etc. 
Payment Method:  Check or EFT 
ACH Existence:  Indicates if ACH exists. 

No ACH Data – indicates that no ACH data exists for this vendor.  Contact the traveler 
or preparer for resolution. 
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ACH only in Staging Table – indicates that ACH data exists for the vendor, but it has 
not successfully made it from the staging table into NBS.  Contact the NIH Help Desk to 
resolve. 
ACH data exists for Vendor – indicates that ACH data exists for the vendor, but has not 
been included in the invoice.  Update the invoice banking information to resolve 

SSN:  Vendor – Yes, indicates that SSN number exists.  No, indicates that no SSN number 
exists on the supplier record.  In order to process a payment, the SSN number must be on the 
vendor record. 
SSN:  HR – Yes, indicates that SSN number exists on the employee record.  No, indicates that 
no SSN number exists on the employee record.   
If SSN information is missing from both the Vendor and HR records, contact the traveler or 
travel planner. 
If the SSN information exists in HR, but is missing from the Vendor record, contact Government 
Accounting to update. 
Preparer – The name of the individual who prepared the travel document 
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NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch 
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NIHAP Unpaid Invoices Error Resolution 
Report for Payment Batch

The report is run for payment batches that have a status of “Built”
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NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch 
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NIHAP Unpaid Invoices Error Resolution 
Report for Payment Batch

The report displays the same information that is displayed on the 
Unpaid Invoices Detail Report, but is specific to the payment batch 
being built.
All invoices displayed on the report should be removed from the 
payment batch to prevent error and placed on the appropriate 
hold.
Refer to the earlier section for information on interpreting the report 
results.
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Invoice Aging Report 

Description: The Invoice Aging Report displays the unpaid 
invoices and the date that they were due for payment

Purpose: Use this report to identify those invoices that remain 
on the Invoice Workbench that have yet to be paid

Source: Accounts Payable

Frequency: This report should be run periodically throughout the 
month

 
Selected Report Headings 
Due Date. Date an invoice is due, assuming no discounts are taken (displayed if Invoice Detail 
option is set to Yes). 
Days Due. Number of days until an invoice is due.  
Amount Remaining. Amount remaining for payment. The total amount of an invoice equals the 
Amount Remaining divided by the % Unpaid. If an invoice includes two scheduled payments in 
different periods, this calculation includes all Amounts Remaining periods. 
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Invoice Aging Report 
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Invoice Aging Report 

Sample report parameters:

 
Selected Report Parameters 
Sort Invoices By. 

•   Invoice Type. Sorts the report by invoice type and then by supplier. 
•   Supplier Name. Sorts the report alphabetically by supplier name. 

Include Invoice Detail. 
•   Yes. Displays invoice detail when showing the invoice payments due to a supplier. 
(Recommended) 
•   No. Summarizes the total invoice payments due to a supplier without displaying each 
invoice. 

Include Site Detail. 
•   Yes. Displays site detail and sorts by supplier site. (Recommended) 
•   No. Displays only the name of each supplier. 

Minimum Amount Due. The report includes invoice information for invoices that have invoice 
amounts greater than this Minimum Amount Due and that fall within the aging period you 
specify.  
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Maximum Amount Due. The report includes invoice information for invoices that have invoice 
amounts less than this Maximum Amount Due and that fall within the aging period you specify. 
Invoice Type. Enter the type (Credit Memo, Debit Memo, Expense Report, Interest, Mixed, 
Prepayment, Withholding Tax, or Standard) for the invoices you want to review, or leave this 
field blank to run this report for invoices with all invoice types. 
Supplier Name. If you want to submit this report for only one supplier, enter the supplier name. 
Aging Period Name. The report displays unpaid invoices for the aging periods. 
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Resolving Invoice and Payment Processing 
Issues

For assistance in resolving invoice and payment processing errors, 
refer to Chapter “Invoice and Payment Processing Error 
Resolution” in this Student Guide
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Accounts Payable Supervisor Report

On a daily basis, the NIHAP Unpaid Invoices Supervisor Summary report 
should be run to get an summary of invoices that are:

Missing SSN
Missing ACH
Missing Address Information
Missing ACH, but contain Address and SSN Information
Contain ACH in the Vendor but not on the Invoice
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NIHAP Unpaid Invoices Supervisor Summary Report 
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NIHAP Unpaid Invoices Supervisor Summary 
Report 

Description: The custom report displays summary information on 
invoices missing required banking, SSN, or address 
information by IC

Purpose: This report should be used to track how many invoices are 
missing payment data, determine which invoices need to 
be updated with ACH information, and how many invoices 
currently set for EFT contain the necessary information for 
a check payment
Note:  This report does not include patient, USB, manually 
entered, or cancelled invoices or debit memos.

Source: Accounts Payable

Frequency: Daily

 
Selected Report Headings 
IC = IC Name 
Missing SSN – Invoices missing SSN information in the Vendor records 
Missing ACH – Vendors missing SSN information 
Missing Address Field – Vendors missing address information 
Missing ACH with Address and SSN – Invoices missing ACH information, but that contain 
address and SSN information.  These invoices could be paid by check. 
ACH in Vendor not Invoice – Invoices eligible for payment if the invoice is updated to include 
the Vendor’s ACH information. 
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Open Advance Report 

Description: The Open Advance Report displays the open travel 
advances in accounts payable.  

Purpose: This report can be used to monitor the open travel 
advances pending from travelers.

Source: NIH Data Warehouse

Frequency: As needed
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Running Accounts Payable Maintenance Reports 
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Lesson Summary

After this lesson you learned how to run:

• the Invoices on Hold Report

• the NIHAP Unpaid Invoices Detail Report

• the NIHAP Unpaid Invoices Error Resolution Report for Payment 
Batch

• the Unaccounted Transaction Report

• the Invoice Aging Report

• the NIH Unpaid Invoices Supervisor Summary Report
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Accounts Payable Inquiry 
Chapter 10 
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Accounts Payable Inquiry 

Accounts Payable Inquiry

Track 2 End User Training
Fall 2003

 



 

Accounts Payable Inquiry   
 Chapter 10 - Page 3  

Lesson Objectives 

Page 1

Lesson Objectives 

After this lesson you should know how to:

• Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Locating and Viewing Invoices 
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Locating and Viewing Invoices 

After this lesson you should know how to:

Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Travel Invoices from NBS Travel Manager

Debit Memo

Standard

Standard

Standard

Prepayment

Invoice Type

Local travel vouchersTRx

Debit Memos for excess advancesTRxV#-DM
Invoices for TMC ChargesTRxV#-CB

Invoices payable to Travel upon approval of 
a voucher

Travel Advances

Invoice Description

TRxV#

TRx-AD
Invoice Name

The following invoices are interfaced from the NBS Travel Manager.
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Travel Invoices Created Manually 
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Travel Invoices Created Manually

Debit Memo

Standard

Standard

Invoice Type

Debit memos resulting from an 
adjustmentTRxV#-DM ADJ

Invoices to refund money to a sponsorTRxV#-SR
Invoices to clear outstanding advancesTRxV#-DM-LQAD

Invoice DescriptionInvoice Name

The following invoices may be created manually as a result of a need for 
an adjustment to an already approved travel voucher.
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Travel Invoices Generated from GTA Reconciliation 
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Travel Invoices Generated from GTA 
Reconciliation

Credit Memo

Debit Memo

Standard

Invoice Type

Credit memos for credits received on TMC fileTRxV#-CB CM GTA

Debit memos resulting from GTA 
ReconciliationTRxV#-CB DM GTA

Adjusting entries resulting from GTA 
reconciliationTRxV#-CB GTA

Invoice DescriptionInvoice Name

The following invoices may be created as a result of the reconciliation of 
the TMC file to the invoices in Accounts Payable.
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Searching for Invoices using the Find Invoices 
Window

Use the find invoice window to locate supplier invoices

1

2

 
•     Enter your search criteria. 
•     Select the Find button to execute your search. 
 
Note:  In order to select certain search criteria, you must select an additional criteria for the 

search.  For example, the system will not allow you to search for all paid invoices without 
first selecting a specific supplier, invoice type, or other search criteria. 

 
Selected Search Criteria 
Supplier  

Name:  Select the name of the payee from the LOV 
Taxpayer ID:  Enter the SSN or Taxpayer ID of payee 

Invoice 
Number:  Enter a full or partial invoice number or use the LOV to select a single 

invoice 
Type:  Select the type of invoice (Standard, Prepayment, Debit Memo, Credit Memo) 
Amounts:  To and From:  Enter a range of invoice amounts 
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Dates – To and From:  Enter a date range for the invoice 
Pay Group:  Select a pay group from the LOV 
Payment Method (Available as an option under drop down menu):  Select a payment 

method from the LOV 
Terms: Select the terms from the LOV 

Invoice Status 
Paid:  Select Paid, Unpaid, or Partial paid from the drop down menu 
Accounted:  Select Yes, No, or Partial from the drop down menu 
Status:  Select the appropriate invoice status from the LOV 

Holds 
Status:  Select either Held or Held/Released 
Name:  Select a hold name from the LOV 
Reason:  Defaults after selecting a hold name 
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Searching for Invoices Using Query Mode  

Page 7

Searching for Invoices Using Query Mode

You may also search by using Query mode directly in the Invoices
window.

 
Press the F11 key to enter query mode. 
Enter your search criteria in any of the blue fields.  You may use the % as a wildcard. 
Press Ctrl + F11 to execute the query. 
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Invoices Window 
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Invoices Window

Search results are displayed in the Invoices window.  The values displayed 
in the fields under the scroll bar reflect the invoice which is currently 
highlighted.

For invoice 
TR402V1

Use buttons to 
view invoice 
information

 
Selected Field Descriptions: 
Type:  The type of invoice (Prepayments are advances, Debit Memo and Credit Memo indicate 
that the supplier owes the NIH money) 
Supplier:  The payee of the invoice 
Supplier Number:  A unique number for each supplier 
Invoice Date:  The date of the invoice 
Invoice Number:  The number of the invoice 
Invoice Amount:  The amount of the invoice 
Payment Method:  Indicates the method by which the supplier will be paid.  If the payment 
method is check, the payment may be made in cash from the cashier if the supplier is a clinical 
center patient. 
Pay Group:  AP Advances – travel advances, Patient_Travel – patients and foreign travelers, 
Travel – other non-gta invoices 
Amount Paid: The amount paid on this invoice to date 
Holds:  Indicates the number of holds currently on the invoice 
Status:  The current status of the invoice 
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Distribution Total:  The total amount of accounting distributions for this invoice.  This amount 
should match the invoice total. 
Accounted: Indicates if the accounting transactions have been generated for this invoice.  If the 
status is No, then accounting information has can not be transferred to the General Ledger. 
 
Button Descriptions: 
Holds:  Select to view hold information 
Payments:  Select to view payment information 
Scheduled Payments:  Select to view the scheduled payments for the invoice 
Overview:  Select to view invoice overview 
Distributions:  Select to view accounting information for the invoice 
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Invoice Holds 
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Invoice Holds

You may view the holds that have been place upon and released from an
invoice by selecting the Holds button 
from the Invoices window.

 
In the screen shot above, you may determine that the initial Patient Recorded Pay hold was 
placed upon the invoice on September 11, 2003 by Sironj_nih.  The hold was released on 
September 23, 2003 by Cashier1. 
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Invoice Distribution 
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Invoice Distribution

By selecting the Distribution button on the Invoices window,
the Invoice Distribution window is displayed.

 
The Distributions window displays the ACS value that was debited for the invoice expense.   
You may use the horizontal scroll bar to view the transaction code for the invoice. 
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Invoice Overview Window

By selecting the Overview button on the Invoices
window, the Invoice Overview window is displayed.

 
The invoice overview window displays valuable summary information related to the invoice 
include the  
•Acutal payment amount 
•Payment date 
•Payment document number 
•Active hold name 
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Invoice Payments

By selecting the Payments button on the Invoices
window, the Payments window is displayed.
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Payment Overview

By selecting the Payment Overview button on the Payments window,
the Payment Overview window is displayed.
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Practice Lab

Lab Time

 
Complete Lab 1:  Searching for and Viewing Accounts Payable Invoices 
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Locating and Viewing Payments 

After this lesson you should know how to:

• Locate and View Invoices

Locate and View Payments

• Generate Accounts Payable Reports
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Searching for Payments using the Find 
Payments Window

Use the Find Payments window to locate payments

1

2

 
•     Enter your search criteria. 
•     Select the Find button to execute your search. 
 
Note:  In order to select certain search criteria, you must select an additional criteria for the 

search.   
 
Selected Search Criteria 
Payment 

Number Range:  Enter a range of payment numbers 
Dates Range:  Enter a date range for the payment 
Amounts Range:  Enter a range of payment amounts 
Accounted:  Select Yes, No, or Partial from the drop down menu 
Document Name:  Select a document name from the LOV 
Payment Method:  Select a payment method from the drop down menu 
Batch:  Select a payment batch name from the LOV 
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Supplier  

Name:  Select the name of payee 
Number:  Select the supplier number 
Taxpayer ID:  Enter the SSN or Taxpayer ID of payee 

 
Status 

Status:  Select the payment status from the drop down menu 
Date Range:  Enter a date range 
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Payments Window

Search results are displayed in the Payments window.  User the horizontal 
scroll bar to view additional payment information.

For payment 
8000340

Use buttons to view additional information

 
Selected Field Descriptions 
Type: Batch -paid in a payment batch, Refund - refund against a debit memo, manual - paid 
from an outside system such as the CDWS. 
Document: EFT - Electronic Funds Transfer, Check - Check payment, Check.initials - Cashier 
third party draft payment, Cash.initials - cashier cash payment, USB.Recorded - recorded US 
Bank invoices for reconciliation 
Document Number:  AP payment number 
Payment Amount:  The amount of the payment 
Batch Name:  The payment batch name which is equivalent to the schedule number 
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Payment Overview Button

By selecting the Payment Overview button on the Payments window,
the Payment Overview window is displayed.
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View Invoices Button

By selecting the View Invoices button on the Payments window,
the Invoices window is displayed.
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Invoice Overview Window

By selecting the Invoice Overview button on the Invoices window,
the Invoice Overview window is displayed.

 
The invoice overview window displays valuable summary information related to the invoice 
include the  
•Actual payment amount 
•Payment date 
•Payment document number 
•Active hold name 
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Invoices Window

By selecting the Invoice button on the Invoice Overview window,
the Invoices window is displayed.

 
The Amount Paid field indicates how much has been paid on this invoice.  
The Holds field indicates the number of holds placed on this invoice 
The Accounted field indicates if the accounting transactions have been generated for this 
invoice.  If the status is No, then accounting information has can not be transferred to the 
General Ledger. 
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Practice Lab

Lab Time

 
Complete Lab 2:  Locating and Viewing Payments 
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Selected Accounts Payable Reports 

After this lesson you should know how to:

• Locate and View Invoices

• Locate and View Payments

Generate Accounts Payable Reports
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Invoice History Report 

Description: The Invoice History Report provides information to 
support the balance due on an invoice. It helps you 
quickly identify and review a detailed list of all 
payment activities pertaining to a specific invoice.

Purpose: Use this report to research payment activities related 
to an invoice

Source: Accounts Payable

Frequency: This report should be run as needed

 
Attention: Payments must be accounted before the associated payment activities are 
shown on the Invoice History Report. Run the Payables Accounting Process before 
generating this report to ensure that you are seeing the most accurate invoice history 
information 
 
Selected Report Headings 
Invoice Number:  Invoice number of the invoice. 
Payment Number: Number of the payment document that paid for the invoice. If the 
invoice has not yet been paid, this field is blank. 
Transaction Date: Date of the transaction. 
Activity Type: Activity that affected the balance of the invoice. For the invoice itself, 
this column displays the type of invoice, such as credit memo. For all the payment 
activities, this column displays what the activity is, such as Discount. 
Transaction Amount: Transaction amount in the payment currency. 
Open Balance Amount: Displays the open balance amount of the transaction in the 
payment currency. 
 



 

Accounts Payable Inquiry   
 Chapter 10 - Page 30  

Invoice History Report 

Page 25

Invoice History Report 

Sample report parameters:

 
Selected Report Parameters 
Supplier Name:  If you want to submit the report for one supplier, enter the supplier. Leave this 
parameter blank to submit the report for all suppliers. 
Prepayments Only 
•No. Submit this report for all invoices, including Prepayment type invoices. 
•Yes. Submit this report for only Prepayment type invoices. 
Invoice Number From/To: If you want to limit the report to one invoice or to a range of 
invoices, enter the invoice or invoice range. Leave this parameter blank to submit the report for 
all invoices. 
From/To Invoice Date: If you want to limit the report to one invoice date or to a range of 
invoice dates, enter the date or date range. Leave this parameter blank to submit the report for all 
invoice dates. 
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Submitting a Single Request 

Purpose 

The purpose of this document is to describe how to submit a single request in the NBS Financial 
Modules.  The steps will be the same regardless of the report or program that is being submitted.  
However, the request name and parameters will vary depending upon the module.  In addition, 
the navigation path may be different.  The student guide will describe the exact navigation path 
for each responsibility. 

NBS Financial Modules 

N > Requests > Run 

Submit a New Request 

 

1. Select the OK button. 

Result:  The Submit Request window is displayed. 
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2. Click on the LOV in the Name field and select the report or program you want to run. 

Result:  The Parameters window is displayed.  NOTE:  This window will be different for 
each report that you select. 

 

3. Complete the Parameters window and select the OK button. 

Result:  You are returned to the Submit Requests window. 
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If you want to run the report now for a single time, goto task #10. Otherwise, goto task #4. 

4. Select the Schedule button in the At these times block. 

Result:  The Schedule window is displayed. 
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5. Select the appropriate schedule alterative in the Run the Job... block. 

If you want to run the job once, goto task #6.  

If you want to run the job periodically, goto task #7 Otherwise, goto task #8. 

6. In the Run At field, enter the date and time you want the job to run.  The time should be 
entered in military time (24 hour clock) 

Example: 
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Goto task #9. 

7. Complete the schedule information. 

Example: 
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Goto task #9. 

8. Complete the schedule information. 

Example:   
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9. Select the OK button. 

10. Determine whether or not you want to view the report prior to printing. 

If you want to print the report before viewing it on-line, goto task #11. Otherwise, goto task 
#14. 

11. Select the Options button. 

Result:  The Upon Completion window is displayed. 
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12. Select a printer and the number of copies 

13. Select the OK button. 

14. Select the Submit button. 

Result:  The result will depend upon the report and the schedule that you have selected.  To 
view the output of the request on line, select View > Requests from the menu bar.  This will 
take you to the Requests window. 

End of activity. 
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Saving a Report to a File 

Purpose 

This document describes how to save reports and other types of request output to files in Oracle. 

Before you begin 

Before you begin, ensure that you are located in the Requests window and the request containing 
the output you want to save is visible on the screen. 

NBS Financial Modules 

M > View > Requests 

Requests 

 

1. Place your cursor in the line of the containing the output you want to save. 

2. Select the View Output button. 

Result:  The Report - Request ID... window is displayed. 
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3. From the menu bar, select Tools > Copy File. 

Result:  A browser window displaying your report is opened. 
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4. From the menu bar, select File > Save As. 

Result:  The Save Web Page window is displayed. 
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5. Enter the file location, type, and name and select the Save button. 

6. Close the browser window. 

7. Close the Report - Request ID... window. 

8. Close the Requests window. 

End of activity. 
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Supplier Payment History 

Description: This report provides totals for the payments made to 
each supplier included in the report. If you choose to 
include the invoice details, the paid invoice's invoice 
number, date, invoice amount, and amount paid by 
the payment is displayed. 

Purpose: Use this report to review the payment history for a 
supplier. You can submit this report by supplier or 
supplier type to review the payments you made 
during a time range you specify.

Source: Accounts Payable

Frequency: This report should be run as needed

 
Selected Report Headings 
Address: Address to which payment was sent. 
Account Name: Bank account used for the payment. 
Gross Amount: Invoice amount, displayed in the payment currency. 
Payment Number: Payment document number. For example, check number. 
Payment Amount: Payment amount in the currency in which it was paid.  
Void Date: Void date if you void a payment. If you void a payment, 0.00 is displayed in the 
Functional Amount column and does not include the payment in the payment total. You enter a 
void date when you void a payment.  
Amount Paid: Amount of an invoice that you have paid. (Displayed only if you choose the 
Invoice Detail option) 
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Supplier Payment History Report 

Sample report parameters:

 
Selected Report Parameters 
Supplier Name:  Select the supplier name from the LOV 
Start/End Payment Date:  Enter the date range for the payments. 
Invoice Detail: Enter Yes to include invoice details for each payment. 
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Practice Lab

Lab Time

 
Complete Lab 3:  Submitting Selected Accounts Payable Reports 
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Lesson Summary

In this lesson, you learned how to:

• Locate and View Invoices

• Locate and View Payments

• Generate Accounts Payable Reports
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Supplier Inquiry 
Chapter 11 
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Supplier Inquiry 

Supplier Inquiry

Track 2 End User Training
September 2003
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Lesson Objectives 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information

 



 

Supplier Inquiry   
 Chapter 11 - Page 4  

How the NBS Supplier Table is Utilized 

Page 2

How the NBS Supplier Table is Utilized 

After this lesson you should know:

How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Supplier Table in Oracle

The Supplier Table is the main source of supplier information in NBS. 
Basic supplier information such as name, address, payment method, 
must be entered prior to the creation of a purchase order or AP 
invoice.
Bank information is required prior to the issuance of electronic
payments in AP.

2563 Fernw

1256 Democ

Address

HN2563C

HN2536C

Organization

Citibank152685Jane Doe

Bank of America1526354John Smith

Bank InformationSupplier #Name

PurchasingPurchasing
Accounts
Payable

Purchase Order

Traveler     $375.50

Purchase Order

Impac     $120

Supplier Table

Invoice

Traveler  $375.50

Bank of America
Invoice

Impac    $120
Citibank # 12563

 
Before a purchase order or AP invoice can be set up, the supplier must be entered into the 
Supplier Table. 
 
Before an electronic payment can be issued from AP, the supplier’s bank information must be 
entered into the Bank Table. 
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Source of Supplier Information

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Overview of Supplier and Bank Tables

NBS Travel System

Travelers

ADB

NBS Travel System

Travelers

Individuals

Companies

Supplier TableEmployee Table

Individuals

NBS Travel System

Travelers

Bank Information
(ACH)

HRDB

NED

Bank Table

1

2

3

4

5
6

 
1.  Information for individuals will be interfaced from HRDB (Human Resources Database) and 
NED (NIH Enterprise Directory) into the Employee Table. 
 

-  The process that transfers records from NED to the Employee Table will run on a 
nightly basis. 
-  The process that transfers records from HRDB to the Employee Table will run every 
two weeks. 

 
2. Individuals who are not located in either of those two systems will be entered directly into the 
Employee Table. 

-  Individuals entered into NBS directly include patients and non-nih affiliated persons. 
 
3. The process that brings information from the Employee Table to the Supplier Table and the 
NBS Travel System will run every half hour. 
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4. Vendors have been converted from the ADB.  If any new vendors are required, the request 
should be submitted to the NBRSS- Govt Acctg mailbox. 
 
5. The process that transfers ACH information from the ADB to the NBS Bank Table will run on 
a nightly basis. 
 
6. ACH information for Phoenix patients, non-NIH affiliated travelers and new sponsors must be 
entered into the NBS manually. 
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Entering New Suppliers

New suppliers will be created 
upon request from the 
payment processing office
Government Accounting must 
receive the following 
information:

Name of the Supplier
Supplier Address
Supplier Taxpayer ID
ACH Information
Supplier Contacts (optional)

Supplier Setup Request

Please set up the following
sponsor as a supplier.

The NIH will refund money to this 
organization due to overpayment.

Name: Pew Charitable Trusts
Tax ID : 253652363
Address: 1254 Lincoln Ave

Chicago, IL 45256

ACH submitted

 
The request to add a new supplier should be sent to the NBRSS – Govt Acctg mailbox. 
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NBS ACH Source and Manual Entry Process

The chart below describes the source of ACH information in the NBS.

Entry Process
IC faxes ACH Request form to Government Accounting
Government Accounting reviews request for completeness
Government Accounting enters ACH information

Traveler Type NBS ACH 
Source

Employees ADB Vendor File 
Domestic and Foreign Fellows with US bank account ADB Vendor File
Foreign Fellows without US bank account N/A
Consultants/Contractors ADB Vendor File
Committee Members/Appointments ADB Vendor File 
Bethesda CC Patients N/A
Baltimore Patients N/A
Phoenix Patients OFM
Non-NIH Affiliated Persons OFM
Foreign Non-NIH Affiliated Persons N/A
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Searching for Suppliers 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

How to search for suppliers

• How to review supplier information
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Searching NBS for Supplier

2.  Enter Search 
Criteria

3.   Click 
Find

1.  Select the 
Find button

 
Navigate to N > Suppliers > Inquiry. 
•   Select the Flashlight on the Applications toolbar. 
•   Enter your search criteria in the Find Suppliers window. 
•   Select the Find button. 
 Result: Supplier Record is displayed in the Suppliers window. 
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Records for Individuals in the Supplier Table

In order to pay an individual through Accounts Payable, the individual 
must be set up as a supplier
The Supplier Name field for individuals contains their name and their 
employee number.

 
Supplier Name is equal to the Employee Name:Employee Number for individuals. 
 
Taxpayer ID field is populated with the Social Security Number for individuals. 
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Other Suppliers

OFM must maintain other supplier records such as:
Impac Government Services 
Sponsor organizations that have overpaid for travel
Other vendors
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Reviewing Supplier Information 

After this lesson you should know:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

How to review supplier information
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Viewing Supplier Records

Each supplier will have:
1. A header record that contains basic organizational information
2. A supplier site that contains address, banking, and contact information

1

2
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Vendors - Viewing Supplier Information 

Purpose 

The purpose of this document is to describe how to view a supplier in the supplier table.  This 
document does not cover entering banking information for a supplier. 

NIH Payables User 

N > Suppliers > Inquiry 

Suppliers 

 

1. Select the Find button on the application toolbar. 

Result:  The Find Suppliers window is displayed. 
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2. Enter your search criteria as described below: 

 
Field Description 

Supplier Name Enter the supplier's name using the appropriate wildcard 
characters 

Supplier Number Enter the supplier number 
Alternate Name Enter the alternate name for the supplier 
Taxpayer ID Enter a SSN or company's taxpayer ID.   

Note:  Do not use dashes 
Tax Registration Number Enter the organization's tax registration number 

Note:  This is generally used for foreign companies 
Inactive Date Range Enter a date range during which the supplier became inactive 
Supplier Type Select the supplier type from the LOV 
Employee Name Enter the employee's name 
Employee Number Enter the employee number 
Parent Supplier Enter the name of the parent supplier 
Parent Number Enter the number of the parent supplier 
Payment Priorities Range Enter the payment priorities range 
Reporting Name Select the supplier's reporting name 
Payment Terms Select the supplier's payment terms from the LOV 
Pay Group Select the supplier's pay group from the LOV 
Reportable:  Federal Select if the supplier is reportable on a federal basis 
Reportable: Income Tax 
Type 

Select the supplier's income tax type 

Reportable: State Select the supplier's state 

3. Select the Find button. 
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Result:  Your search results are displayed in the Suppliers window. 

 

Note:  Use the down arrow on your keyboard to view your results if multiple records 
matched your query. 

4. Select the Classification Tab to review the supplier's classification information. 

Result:  The Classification region is displayed. 
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Field Description 

Type Indicates the type of supplier 
Employee Name Displays the name if an employee 
Employee Number Displays the employee number 
One Time Enabled if one-time supplier during setup 
SIC Displays the Standard Industry Code 
Minority Owned Indicates minority ownership 
Small Business Enabled if the supplier is marked a small business 
Woman Owned Enabled if the supplier is marked a woman-owned business 
 

5. Select the Sites button. 

Result:  The Supplier Sites window is displayed. 
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6. Use the down arrow on your keyboard to view other supplier sites 

7. View the address information 

 
Field Description 

Alternate Name Enter an alternate name for the site 
Alternate Address Enter an alternate address for the site 
Country Select the appropriate country from the LOV. 
Address Enter the address line information 
City Enter the city name 
State Enter the state 
Postal Code Enter the postal code 
Province Enter the province abbreviation 
County Enter the county name 
Language Enter the language used at that site 
Inactive On Enter the date the site will no longer be active 

8. Review the information on the General region tab. 

 
Field Description 

Site Uses Pay - Enabled if this site can be used for payments 
Primary Pay - Enabled if this is the primary payment site 
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Purchasing - Enabled if site can be used for purchase 
orders 
RFQ Only  - Enabled if you do not allow entering 
purchase orders for a supplier site 
Procurement Card - Accepts the credit card brands of 
your procurement cards 

Communication Contact information for this supplier site. 

9. Select the Contacts tab to review supplier contacts. 

Result:  The fields related to supplier contacts are displayed. 

 

 
Field Description 

Name: Last The contact's last name 
Name: First The contact's first name 
Name: M The contact's middle initial  
Prefix The appropriate prefix for the contact 
Title The contact's title 
Telephone The contact's telephone number 
Inactive On The date on which the contact will no longer be active 
Department The department name 
Alternate Contact Name The name of an alternate contact 

10. Select the Control tab to view any restrictions placed on the supplier's activities 

Results:  The control-related fields are displayed. 
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Field Description 

Invoice Amount Limit The supplier's invoice amount limit 
Invoice Match Option Displays the invoice match option 
Hold All Payments Enabled if you want to hold all payments to the supplier 
Hold Unmatched Invoices Enabled if you want to hold all unmatched invoices to the 

supplier 
Hold Unvalidated Invoices Enabled if you want to hold all unvalidated invoices to the 

supplier 
Payment Hold Reason Displays the reason for the payment hold 

11. Select the Payment tab to review payment information for the Supplier. 

Result:  The payment-related fields are displayed. 

 

 
Field Description 

Terms Displays the supplier's payment terms  
Pay Group The supplier's pay group can be used to segregate invoices 

in payment batches 
Payment Priority The supplier's payment priority 
Terms Date Basis The basis on which terms date is determined 
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Pay Date Basis The basis on which payments are made 
Payment Method The default payment method in accounts payable 

12. Select the Bank Accounts tab to review the bank information entered for this supplier. 

Result:  The bank account fields are displayed. 

 

 
Field Description 

Name Displays the Tax ID number of the individual or company 
Number Displays the account number 
Primary Indicates that this is a primary bank account for the supplier 
Effective Date Range Indicates the effective date of the bank information 
Bank Name and Number Indicates the bank name of the highlighted bank account 
Branch Name and Number Displays the routing number of the highlighted bank account

13. Close the Supplier Sites window. 

Result:  You are returned to the Supplier window. 
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End of activity. 
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Lesson Summary 

In this lesson, you learned:

• How the Supplier Table is utilized in the NBS

• How individual and organization supplier information is 
entered into the Supplier and Bank Tables

• How to search for suppliers

• How to review supplier information
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Important Information
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Initial Oracle Set Up Required

The first time you log into the NBS, you will be required to:
Download Oracle J-Initiator and
Update your internet browser security settings

Refer to the technical guidance provided on the NBS
Technical website:http://nbs.nih.gov/technical.html
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NBS Travel Support Resources

NBS Travel Web links available 24/7
NBS Oracle Online Help and Ref erence:  http://nbs.nih.gov/training.html

NIH Portal Support
Phone NIH Help Desk at 6-HELP (301.496.4357)
Portal website address:  http://my.nih.gov

NBS Customer Support
Phone: Call 5-NBS7 (301.435.6277)
E-mail: Send e-mail to tasc@NIH.gov

Web Request f or Support: Submit to: http://support.cit.nih.gov

nVision
nVision is an ev olution of  the NIH Data Warehouse, and it is the new reporting sy stem designed 
to work in concert with the NBS. nVision is a business intelligence system that deliv ers NIH-
def ined standard reports and f acilitates the dev elopment of  user-created ad hoc reports to 
support decision-making and analysis. The f irst NBS module to be supported by  nVision is 
Trav el.
E-mail: Send e-mail to nVisionSupport@nih.gov

Web Site f or inf ormation: http://nvision.nih.gov
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Contacting NBS Customer Support

Provide the following information to help facilitate issue resolution:
Oracle Responsibility Name
What are you trying to accomplish
The title of the w indow in which you are located
A description of the problem that includes the exact error message you receive 
and where the error message is located
A description of what steps you took prior to receiving the error, including the 
exact traveler name, invoice number, etc that you were trying to process
What happens if  you try to proceed
The impact of the error on your work and when you need it to be resolved
Who to contact in the event that you are not available

Phone: Call 6-HELP (301.496.4357)
E-mail: Send e-mail to helpdesk@NIH.gov
Web Request for Support: Submit to: 
http://support.cit.nih.gov
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Evaluation

Please take a moment to complete the 
on-line training evaluation

www.surveymonkey.com/s.asp?u=44111257699

Your comments are important to us!
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Good Luck

Good Luck!
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